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Related	Documentation
The	following	documents	contain	information	that	you	might	find	helpful
as	you	use	this	help	file:

DAQ	Getting	Started	Guide—This	guide	describes	how	to	install
your	NI-DAQmx	software,	your	DAQ	device,	and	how	to	confirm
that	your	device	is	operating	properly.
SCXI	Quick	Start	Guide—This	guide	describes	how	to	install	and
configure	your	SCXI	chassis	and	modules,	and	how	to	confirm	that
the	chassis	is	operating	properly.
DAQ	Assistant	Help—This	help	file	contains	information	on	using
the	DAQ	Assistant	to	graphically	configure	common	measurement
tasks,	channels,	or	scales.
Measurement	&	Automation	Explorer	Help	for	Traditional	NI-DAQ
(Legacy)—This	help	file	contains	information	on	using	the	MAX
interface	to	add,	configure,	and	delete	DAQ	and	SCXI	devices
supported	by	Traditional	NI-DAQ	(Legacy).
NI-DAQmx	Help—This	help	file	explains	key	NI-DAQmx	concepts,
describes	how	to	create	common	applications,	and	details	device-
specific	information	needed	to	use	NI-DAQmx.
Device	documentation—This	documentation	describes	the
electrical	and	mechanical	aspects	of	your	device	and	contains
information	concerning	its	operation	and	programming.



Using	Help
Conventions
Navigating	Help
Searching	Help
Printing	This	Help	File



Conventions
The	following	conventions	appear	in	this	help	file:
<	> Angle	brackets	indicate	function	keys.

» The	»	symbol	leads	you	through	nested	menu	items	and	dialog	box	options	to	a	final
action.	The	sequence	File»Page	Setup»Options	directs	you	to	pull	down	the	File	menu,
select	the	Page	Setup	item,	and	select	Options	from	the	last	dialog	box.
The	 	symbol	indicates	closed	drop-down	text.	Click	the	symbol	to	display	the	text.

The	 	symbol	indicates	open	drop-down	text.	Click	the	symbol	to	hide	the	text.

This	icon	denotes	a	note,	which	alerts	you	to	important	information.

This	icon	denotes	a	caution,	which	advises	you	of	precautions	to	take	to	avoid	injury,	data
loss,	or	a	system	crash.

bold Bold	text	denotes	items	that	you	must	select	or	click	on	in	the	software,	such	as	menu
items	and	dialog	box	options.	Bold	text	also	denotes	parameter	names,	emphasis,	or	an
introduction	to	a	key	concept.

dark	red Text	in	this	color	denotes	a	caution.

green Underlined	text	in	this	color	denotes	a	link	to	a	help	topic,	help	file,	or	Web	address.

italic Italic	text	denotes	variables	or	cross	references.	This	font	also	denotes	text	that	is	a
placeholder	for	a	word	or	value	that	you	must	supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you	should	enter	from	the	keyboard,
sections	of	code,	programming	examples,	and	syntax	examples.	This	font	is	also	used	for
the	proper	names	of	disk	drives,	paths,	directories,	programs,	subprograms,	subroutines,
device	names,	functions,	operations,	variables,	filenames	and	extensions,	and	code
excerpts.



Navigating	Help	(Windows	Only)
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window	or	use	the	following	toolbar	buttons	located	above
the	tabs:

Hide—Hides	the	navigation	pane	from	view.
Locate—Locates	the	currently	displayed	topic	in	the	Contents	tab,
allowing	you	to	view	related	topics.
Back—Displays	the	previously	viewed	topic.
Forward—Displays	the	topic	you	viewed	before	clicking	the	Back
button.
Options—Displays	a	list	of	commands	and	viewing	options	for	the
help	file.



Searching	Help	(Windows	Only)
Use	the	Search	tab	to	the	left	of	this	window	to	locate	content	in	this	help
file.	If	you	want	to	search	for	words	in	a	certain	order,	such	as	"related
documentation,"	add	quotation	marks	around	the	search	words	as	shown
in	the	example.	Searching	for	terms	on	the	Search	tab	allows	you	to
quickly	locate	specific	information	and	information	in	topics	that	are	not
included	on	the	Contents	tab.



Wildcards
You	also	can	search	using	asterisk	(*)	or	question	mark	(?)	wildcards.
Use	the	asterisk	wildcard	to	return	topics	that	contain	a	certain	string.	For
example,	a	search	for	"prog*"	lists	topics	that	contain	the	words
"program,"	"programmatically,"	"progress,"	and	so	on.
Use	the	question	mark	wildcard	as	a	substitute	for	a	single	character	in	a
search	term.	For	example,	"?ext"	lists	topics	that	contain	the	words
"next,"	"text,"	and	so	on.



Nested	Expressions
Use	nested	expressions	to	combine	searches	to	further	refine	a	search.
You	can	use	Boolean	expressions	and	wildcards	in	a	nested	expression.
For	example,	"example	AND	(program	OR	VI)"	lists	topics	that	contain
"example	program"	or	"example	VI."	You	cannot	nest	expressions	more
than	five	levels.



Boolean	Expressions
Click	the	 	button	to	add	Boolean	expressions	to	a	search.	The	following
Boolean	operators	are	available:

AND	(default)—Returns	topics	that	contain	both
search	terms.	You	do	not	need	to	specify	this
operator	unless	you	are	using	nested
expressions.
OR—Returns	topics	that	contain	either	the	first
or	second	term.
NOT—Returns	topics	that	contain	the	first	term
without	the	second	term.
NEAR—Returns	topics	that	contain	both	terms
within	eight	words	of	each	other.



Search	Options
Use	the	following	checkboxes	on	the	Search	tab	to	customize	a	search:

Search	previous	results—Narrows	the	results	from	a	search	that
returned	too	many	topics.	You	must	remove	the	checkmark	from
this	checkbox	to	search	all	topics.
Match	similar	words—Broadens	a	search	to	return	topics	that
contain	words	similar	to	the	search	terms.	For	example,	a	search
for	"program"	lists	topics	that	include	the	words	"programs,"
"programming,"	and	so	on.
Search	titles	only—Searches	only	in	the	titles	of	topics.



Printing	Help	File	Topics	(Windows	Only)
Complete	the	following	steps	to	print	an	entire	book	from	the	Contents
tab:

1.	 Right-click	the	book.
2.	 Select	Print	from	the	shortcut	menu	to	display	the	Print	Topics

dialog	box.
3.	 Select	the	Print	the	selected	heading	and	all	subtopics	option.

Note		Select	Print	the	selected	topic	if	you	want	to	print
the	single	topic	you	have	selected	in	the	Contents	tab.

4.	 Click	the	OK	button.



Printing	PDF	Documents
This	help	file	may	contain	links	to	PDF	documents.	To	print	PDF
documents,	click	the	print	button	located	on	the	Adobe	Acrobat	Viewer
toolbar.



Introduction	to	Measurement	&	Automation	Explorer	(MAX)
You	can	configure	your	National	Instruments	DAQ	and	SCXI	products
with	MAX.	MAX	informs	other	programs	about	which	products	you	have
in	the	system	and	how	they	are	configured.	Use	MAX	to	add,	configure,
test,	and	remove	a	DAQ	or	SCXI	product.

Note		Special	considerations	exist	for	specific	operating	systems.	Refer	to	Operating	System
Considerations	for	more	information.

To	check	the	system	resources	used	by	a	DAQ	device	and	to	select
attached	accessories,	expand	Devices	and	Interfaces»NI-DAQmx
Devices	in	the	configuration	tree.	Click	your	device	to	see	information	on
the	device	resources.	The	information	appears	in	the	middle	pane.	Click
the	Attributes	tab	to	see	hardware-specific	information.	Click	the	Device
Routes	tab	to	see	routes	that	can	be	made	within	the	device.	For	more
information,	refer	to	Accessing	DAQ	Devices.

Note		Press	<F5>	or	select	View»Refresh	to	refresh	the	screen.



Capabilities	of	MAX	for	NI-DAQmx
You	can	use	MAX	for	the	following	measurement	configuration	actions:

Configuring	resources	and	other	device-specific	settings	for
measurement	devices	in	the	system
Testing	the	resources	and	the	functionality	of	measurement
devices	in	the	system

When	you	run	an	application	using	NI-DAQ	software,	the	software	reads
the	configuration	to	determine	the	devices	you	have	configured.
Therefore,	you	first	must	configure	DAQ	devices	with	MAX.	If	MAX
cannot	detect	the	device,	use	the	Device	Manager	to	add	a	new	device.
In	NI-DAQmx,	you	can	use	the	DAQ	Assistant	to	configure	and	edit
tasks,	channels,	and	scales.	Virtual	channel	configuration	is	required	in
NI-DAQmx.



Getting	Started
The	following	drop-down	text	includes	links	to	information	on	completing
the	most	common	DAQ-	and	SCXI-related	tasks	in	MAX.



	DAQ	Devices



	RT	Series	DAQ	Devices



	RTSI	Cable



	SCXI	Chassis



	SCXI	Modules



	SCC	Devices



	NI-DAQmx	Simulated	Devices



	TEDS	Carrier



Accessing	Device	Documentation
You	can	access	online	device	documentation	from	MAX.	To	search
ni.com/manuals	for	documentation,	complete	the	following	steps:

1.	 Right-click	the	device	in	the	configuration	tree.
2.	 Select	Help»Online	Device	Documentation.
3.	 A	browser	window	opens	to	ni.com/manuals,	with	the	results	of	a

search	for	relevant	device	documentation.



DAQ	Devices
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	DAQ	devices.
Accessing	DAQ	Devices
Adding	DAQ	Devices
Configuring	DAQ	Devices
Testing	DAQ	Devices
Resetting	DAQ	Devices
Calibrating	DAQ	Devices
Removing	DAQ	Devices



Accessing	DAQ	Devices
To	access	DAQ	devices,	expand	Devices	and	Interfaces»NI-DAQmx
Devices	in	the	configuration	tree.	If	you	are	using	a	remote	RT	target,
expand	Remote	Systems,	find	and	expand	your	target,	and	expand
Device	and	Interfaces.	You	can	perform	the	following	tasks:

Add	a	new	device	to	your	configuration
Configure	a	device	in	your	configuration
Test	a	device	in	your	configuration
Remove	a	device	from	your	configuration

The	right	pane	of	the	MAX	interface	displays	information	about	the	device
highlighted	in	Devices	and	Interfaces.	The	format	of	the	information
displayed	in	the	device	view	varies	depending	on	the	selected	device.



Adding	DAQ	Devices
To	add	DAQ	devices,	complete	the	following	steps:

1.	 Install	the	DAQ	device	according	to	the	DAQ	Getting	Started
Guide.

2.	 Open	MAX	to	scan	your	operating	system	for	new	devices.	New
NI-DAQmx	devices	appear	in	Devices	and	Interfaces»NI-
DAQmx	Devices.

If	you	are	using	a	remote	RT	target,	the	new	devices	appear	under
Remote	Systems»target»Devices	and	Interfaces»NI-DAQmx
Devices.
For	information	on	configuring	the	DAQ	device,	refer	to	Configuring	DAQ
Devices.
Refer	to	Measurement	&	Automation	Explorer	Help	for	Traditional	NI-
DAQ	(Legacy)	for	information	on	adding	and	configuring	devices	with	the
Traditional	NI-DAQ	(Legacy)	API.
If	you	are	installing	a	Plug	and	Play	device	and	the	operating	system	did
not	detect	it,	refer	to	Plug	and	Play	Devices	in	Windows	2000/XP.

Note		When	an	NI	USB-9xxx	device	is	first	plugged	in,	it	appears	in	MAX	as	an	NI	USB-9162
until	the	correct	module	is	automatically	identified	and	displayed	in	MAX.



Configuring	and	Renaming	DAQ	Devices
To	configure	a	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	device	you	want	to	configure.	Select	Properties.
–or–
Select	the	device	you	want	to	configure.	Click	Properties	in	the
MAX	toolbar.

3.	 Select	the	appropriate	tab	to	set	the	configuration	options.	The
configuration	options	you	see	depend	on	the	DAQ	device.	The
RTSI	Configuration	tab	appears	only	when	configuring	a	DAQ
device	with	RTSI	capabilities.
	RTSI	Configuration
	Accessory	Settings

4.	 Click	OK	when	you	are	finished.
To	rename	a	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	device	you	want	to	rename.	Select	Rename.
–or–
Select	the	device	you	want	to	rename.	Press	<F2>.

3.	 Type	the	new	device	name,	using	the	following	guidelines:
Use	any	alphanumeric	characters.
Do	not	use	non-alphanumeric	characters,	such	as	dashes,
punctuation,	or	spaces.



You	can	use	underscores	within	the	name	of	the	device,	but
you	cannot	use	leading	underscores,	such	as	_Dev1.
You	must	use	no	more	than	256	characters.

4.	 Press	<Enter>	or	click	anywhere	on	the	screen	when	finished.
To	view	device	pinouts,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	a	device.	Select	Device	Pinouts.
–or–
Select	the	device.	Click	Device	Pinouts	in	the	MAX	toolbar.



Testing	DAQ	Devices
Use	test	panels	to	test	the	functionality	of	your	DAQ	device.	To	run	test
panels,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	device	you	want	to	test.	Select	Test	Panels	to
display	the	test	panel	for	the	device.
–or–
Select	the	device	you	want	to	test.	Click	Test	Panels	in	the	MAX
toolbar.
The	test	panel	appears.	You	can	view	the	analog	input,	analog
output,	digital	I/O,	and	counter	I/O	functions	of	the	device	by
clicking	the	tabs	near	the	top	of	the	window.	If	the	device	you	are
testing	is	not	a	multifunction	DAQ	device,	the	window	might	have
fewer	tabs.
Click	Help	for	more	detailed	information	on	using	the	test	panel.

3.	 If	a	problem	occurs	with	the	device,	the	Error	indicator	turns	red.
The	Error	Details	window	shows	detailed	information	about	the
error.

4.	 Click	Close	when	you	are	finished.
Self-tests	perform	a	brief	test	of	device	resources,	without	the	level	of
user	interaction	of	test	panels.	Complete	the	following	steps	to	run	a	self-
test:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	device	on	which	you	want	to	perform	a	self-test.



Select	Self-Test.
3.	 A	message	window	appears	that	indicates	if	the	device	passed	or

failed.	Click	OK	to	continue.
If	a	failure	occurs,	refer	to	your	device	documentation	for	more
information.



Resetting	DAQ	Devices
Resetting	a	DAQ	device	performs	a	hardware	reboot	of	the	device.	A
reset	aborts	any	running	tasks	and	restores	the	device	to	its	default
settings.	Complete	the	following	steps	to	reset	a	device:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	device	you	want	to	reset.	Select	Reset	Device.
–or–
Select	the	device	you	want	to	reset.	Click	Reset	Device	in	the
MAX	toolbar.

3.	 A	message	appears,	indicating	success	or	failure.	Click	OK	to
continue.



Calibrating	DAQ	Devices
Calibrating	a	DAQ	device	consists	of	verifying	the	measurement
accuracy	of	the	device	and	adjusting	for	any	measurement	error.
Complete	the	following	steps	to	calibrate	a	device:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	device	you	want	to	calibrate.	Select	Self-Calibrate.
–or–
Select	the	device	you	want	to	calibrate.	Click	Self-Calibrate	in	the
MAX	toolbar.

A	window	reports	the	status	of	the	calibration.	The	window	closes	when
calibration	is	finished.
To	see	information	on	the	latest	self-calibration,	click	the	Calibration	tab
at	the	bottom	of	the	middle	MAX	pane.

Note		The	self-calibrate	option	and	calibration	tab	are	only	enabled	for	devices	that	support
calibration.



Removing	DAQ	Devices
To	remove	a	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	device	you	want	to	remove	and	select	Delete.
–or–
Select	the	device	you	want	to	delete.	Click	Delete	in	the	MAX
toolbar.

3.	 A	dialog	box	prompts	you	to	confirm	removal	of	the	DAQ	device.
Click	Yes	to	remove	the	device	or	No	to	cancel.

Note		The	delete	option	is	disabled	for	Plug	and	Play	DAQ	devices	that	are	still	present	in	the
system.	Either	uninstall	the	device	in	the	device	manager,	or	power	down	the	computer	and
remove	the	device.



RT	Series	DAQ	Devices	(NI	PCI-7041/6040E)
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	RT	Series	DAQ	devices.
Adding	RT	Series	DAQ	Devices
Configuring	RT	Series	DAQ	Devices
Locking	RT	Series	DAQ	Devices
Rebooting	RT	Series	DAQ	Devices
Removing	RT	Series	DAQ	Devices



Adding	RT	Series	DAQ	Devices
To	add	an	RT	Series	DAQ	device,	complete	the	following	steps:

1.	 Install	the	RT	Series	DAQ	device	according	to	the	device
documentation.

2.	 Open	MAX	to	scan	your	operating	system	for	new	devices.	The
new	device	appears	in	My	System»Devices	and	Interfaces	as
RT::<board	number>.

For	information	on	configuring	the	DAQ	device,	refer	to	Configuring	RT
Series	DAQ	Devices.



Configuring	and	Renaming	RT	Series	DAQ	Devices
To	configure	an	RT	Series	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	configure.	Select	Properties.

–or–
Select	the	device	you	want	to	configure.	Click	Properties	in	the
MAX	toolbar.

3.	 Select	the	appropriate	tab	to	set	the	configuration	options.
	General
	Settings

4.	 Click	OK	when	you	are	finished.
To	rename	a	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	rename.	Select	Rename.
3.	 Type	the	new	device	name.	Use	only	alphanumeric	characters	for

the	name.	Do	not	use	punctuation	or	spaces.	Press	<Enter>	or
click	anywhere	on	the	screen	when	finished.



Locking	RT	Series	DAQ	Devices
Locking	an	RT	Series	DAQ	device	protects	the	device	from	other	users
by	requiring	a	password	to	perform	any	functions	on	the	device.
Complete	the	following	steps	to	lock	a	device:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	lock.	Select	Lock.

–or–
Select	the	device	you	want	to	lock.	Click	Lock	in	the	MAX	toolbar.

3.	 Enter	a	password.	Enter	the	password	again	for	confirmation.
Click	OK	to	lock	the	device.	After	you	lock	the	device,	the	Lock
button	in	the	toolbar	appears	pressed.

Complete	the	following	steps	to	unlock	the	device.
1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	locked	device	you	want	to	unlock.	Select	Lock.

–or–
Select	the	device	you	want	to	unlock.	Click	Lock	in	the	MAX
toolbar.

3.	 Enter	the	password.	Click	OK	to	unlock	the	device.



Rebooting	RT	Series	DAQ	Devices
Rebooting	an	RT	Series	DAQ	device	performs	a	hardware	reboot	of	the
device.	A	reboot	aborts	any	running	tasks	and	restores	the	device	to	its
default	settings.	Complete	the	following	steps	to	reboot	a	device:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	reboot.	Select	Reboot.

–or–
Select	the	device	you	want	to	reboot.	Click	Reboot	in	the	MAX
toolbar.

3.	 A	message	appears,	indicating	success	or	failure.	Click	OK	to
continue.



Removing	RT	Series	DAQ	Devices
To	remove	an	RT	Series	DAQ	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces	in	the	configuration	tree.
2.	 Right-click	the	device	you	want	to	remove	and	select	Delete.
3.	 A	dialog	box	prompts	you	to	confirm	removal	of	the	DAQ	device.

Click	Yes	to	remove	the	device	or	No	to	cancel.



RTSI	Cable
Note		If	you	are	using	a	PXI	device,	you	do	not	need	to	use	a	RTSI	cable.	The	PXI	backplane
includes	RTSI	lines.

Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	a	RTSI	cable.
Adding	a	RTSI	Cable
Configuring	a	RTSI	Cable
Removing	a	RTSI	Cable



Adding	a	RTSI	Cable
To	add	a	RTSI	cable,	complete	the	following	steps:

1.	 Right-click	Devices	and	Interfaces.	Select	Create	New.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Devices	and
Interfaces.	Select	Create	New.

2.	 In	the	Create	New	window,	select	NI-DAQmx	Devices»RTSI
Cable.

3.	 Click	Finish.
You	also	can	add	a	RTSI	cable	without	using	the	Create	New	window.

1.	 Right-click	Devices	and	Interfaces»NI-DAQmx	Devices.
2.	 Select	Create	New	NI-DAQmx	Device»RTSI	Cable.



Configuring	a	RTSI	Cable
To	configure	a	RTSI	cable,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	RTSI	cable	you	want	to	configure.	Select
Properties.
–or–
Select	the	RTSI	cable	you	want	to	configure.	Click	Properties	in
the	MAX	toolbar.

3.	 In	the	RTSI	Bus	Line	Reservation	window,	select	the	checkboxes
of	lines	reserved	for	use	by	drivers	other	than	NI-DAQmx.	Any
lines	left	unchecked	may	be	driven	by	NI-DAQmx.

4.	 Click	OK	when	you	are	finished.
To	rename	a	RTSI	cable,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	RTSI	cable	you	want	to	rename.	Select	Rename.
–or–
Select	the	RTSI	cable	you	want	to	rename.	Press	<F2>.

3.	 Type	the	new	cable	name.	Use	only	alphanumeric	characters	for
the	name.	Do	not	use	punctuation	or	spaces.	Press	<Enter>	or
click	anywhere	on	the	screen	when	finished.

To	add	a	DAQ	device	to	the	RTSI	cable,	complete	the	following	steps:
1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the

configuration	tree.



If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	RTSI	cable	to	which	you	want	to	add	a	device,	and
select	Add	Device	to	RTSI	Cable.

3.	 Select	a	device	from	the	list	of	available	DAQ	devices.
Note		Not	all	DAQ	devices	support	RTSI	cables.	Devices	without	RTSI	support	do	not	appear	in
the	list	of	available	devices.

To	remove	a	DAQ	device	from	the	RTSI	cable,	complete	the	following
steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	RTSI	cable	from	which	you	want	to	remove	a
device,	and	select	Remove	Device	from	RTSI	Cable.

3.	 Select	the	device	to	remove.



Removing	a	RTSI	Cable
To	remove	a	RTSI	cable,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	RTSI	cable	you	want	to	remove.	Select	Delete.
–or–
Select	the	RTSI	cable	you	want	to	remove.	Click	Delete	in	the
MAX	toolbar.

3.	 A	dialog	box	prompts	you	to	confirm	removal	of	the	cable.	Click
Yes	to	remove	the	cable	or	No	to	cancel.



SCXI	Devices
Refer	to	the	following	topics	for	more	information	on	SCXI	chassis	and
modules.



SCXI	Chassis
Adding	an	SCXI	Chassis
Configuring	an	SCXI	Chassis
Removing	an	SCXI	Chassis
Resetting	an	SCXI	Chassis
Testing	an	SCXI	Chassis



SCXI	Modules
Adding	SCXI	Modules
Configuring	SCXI	Modules
Configuring	SCXI	Switch	Modules
Resetting	SCXI	Modules
Removing	SCXI	Modules



SCXI	Chassis
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	SCXI	chassis.
Adding	an	SCXI	Chassis
Configuring	an	SCXI	Chassis
Resetting	an	SCXI	Chassis
Removing	an	SCXI	Chassis
Testing	an	SCXI	Chassis



Adding	an	SCXI	Chassis
Note		If	you	are	using	a	PXI/SCXI	combination	chassis,	you	must	first	identify	the	chassis	using
the	PXI	resource	manager.	Refer	to	the	PXI	help	by	clicking	Help»Help	Topics»PXI.

To	add	an	SCXI	chassis,	complete	the	following	steps:
1.	 Right-click	Devices	and	Interfaces.	Select	Create	New.

If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Devices	and
Interfaces.	Select	Create	New.

2.	 In	the	Create	New	window,	go	to	NI-DAQmx	Device»NI-DAQmx
SCXI	Chassis.	Select	the	SCXI	chassis	you	want	to	add.

3.	 Click	Finish.
You	also	can	add	an	SCXI	chassis	without	using	the	Create	New	window.
Complete	the	following	steps:

1.	 Right-click	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Select	Create	New	DAQmx	Device»NI-DAQmx	SCXI	Chassis.
3.	 Select	the	chassis	from	the	list	of	available	SCXI	chassis.

To	finish	adding	an	SCXI	chassis,	complete	the	following	steps:
1.	 In	the	Create	New	SCXI	Chassis	window,	configure	the	following

settings:
	Chassis	Communicator
	Communicating	SCXI	Module	Slot
	Chassis	Address
	Auto-Detect	All	Modules

2.	 Click	Save	when	you	are	finished.	The	SCXI	Chassis
Configuration	window	opens.



Configuring	an	SCXI	Chassis
To	configure	an	SCXI	chassis,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	SCXI	chassis	you	want	to	configure.	Select
Properties.

3.	 The	SCXI	Chassis	Configuration	window	opens.	The	Module	tab
is	selected	by	default.	Use	the	settings	on	the	Modules	tab	to	add
and	configure	your	SCXI	modules.

4.	 Click	the	Chassis	tab	to	see	the	following	configuration	settings:
	Chassis	Communicator
	Communicating	SCXI	Module	Slot
	SCXI	Communication	Mode	(PXI/SCXI	combination	chassis
only)
	Chassis	ID
	Chassis	Address
	Multichassis	Daisy-Chain	Index

5.	 If	you	want	NI-DAQ	to	automatically	detect	the	SCXI	modules	in
the	chassis,	check	Auto-Detect	All	Modules.

6.	 The	message	area	at	the	top	of	the	window	indicates	whether	the
configuration	is	valid.	Error	and	warning	messages	explain	what
problems	to	resolve.	When	the	message	indicates	a	valid
configuration,	click	OK.



Resetting	an	SCXI	Chassis
Resetting	an	SCXI	chassis	performs	a	hardware	reboot	of	the	chassis
and	modules.	Complete	the	following	steps	to	reset	a	chassis:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	chassis	you	want	to	reset.	Select	Reset	Chassis.
3.	 An	explanatory	message	appears,	indicating	success	or	failure.

Click	OK	to	continue.



Testing	an	SCXI	Chassis
To	test	an	SCXI	chassis,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	SCXI	chassis	you	want	to	test.	Select	Test.
–or–
Select	the	SCXI	chassis	you	want	to	test.	Click	Test	in	the	MAX
toolbar.

MAX	verifies	your	SCXI	configuration	by	reading	the	module	ID	of	each
configured	SCXI	module	and	comparing	it	against	the	modules	you
configured.	MAX	notifies	you	if	there	is	any	discrepancy	or	if	the	SCXI
communication	path	was	not	set	up	correctly.
Refer	to	your	SCXI	chassis	and	module	documentation	if	you	experience
problems	with	your	configuration.



Removing	an	SCXI	Chassis
To	remove	an	SCXI	chassis,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	chassis	you	want	to	remove.	Select	Delete.
–or–
Select	the	SCXI	chassis	you	want	to	remove.	Click	Delete	in	the
MAX	toolbar.

Caution		This	action	also	removes	any	SCXI	module	configuration	information	you	configured
in	the	selected	chassis.



SCXI	Modules
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	SCXI	modules.
Adding	SCXI	Modules
Configuring	SCXI	Modules
Configuring	SCXI	Switch	Modules
Resetting	SCXI	Modules
Testing	SCXI	Modules
Removing	SCXI	Modules



Adding	SCXI	Modules
Note		Before	you	add	an	SCXI	module,	you	must	add	an	SCXI	chassis.

To	add	an	SCXI	module,	complete	the	following	steps:
1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.

If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	SCXI	chassis	to	which	you	want	to	add	a	module.
Select	Properties.
–or–
Expand	the	SCXI	chassis	and	right-click	an	empty	slot.	Select
Insert.

3.	 In	the	SCXI	Chassis	Configuration	window,	click	the	Modules	tab.
Select	the	module	you	want	to	add	from	the	Modules	drop-down
listbox	for	the	desired	slot.

4.	 Type	the	new	device	name	in	Device	Name.	Use	only
alphanumeric	characters	for	the	name.	Do	not	use	punctuation	or
spaces.

5.	 Select	a	connected	accessory	from	the	Accessory	drop-down
listbox.

6.	 Click	Details	to	configure	the	module	settings.
7.	 Click	OK	when	you	are	finished.



Configuring	SCXI	Modules
To	configure	an	SCXI	module,	complete	the	following	steps:

1.	 In	the	SCXI	Chassis	Configuration	window,	click	Details	next	to
the	desired	module.	You	also	can	configure	the	module	without
opening	the	SCXI	Chassis	Configuration	window.	In	the
configuration	tree,	expand	the	chassis	and	right-click	the	module
you	want	to	configure	and	select	Properties.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	the	chassis.	Right-click
the	module	you	want	to	configure	and	select	Properties.
The	Module	Configuration	window	opens	with	the	following	tabs:
	Jumpers	(1100,	1120/D,	1121,	1140	only)
	Accessory
	Cabling

2.	 Multichassis	Daisy-Chain	Index—Select	the	index	of	the	SCXI
chassis	of	the	module	in	a	multichassis	configuration.	You	can
daisy-chain	up	to	eight	SCXI	chassis.	This	setting	appears	only	if
two	or	more	SCXI	chassis	have	been	configured.

3.	 Click	OK	in	the	Module	Configuration	window	when	you	are
finished.

4.	 Click	OK	in	the	SCXI	Chassis	Configuration	window.
Note		Refer	to	Configuring	SCXI	Switch	Modules	for	information	on	switch	module
configuration.



Testing	SCXI	Modules
Use	test	panels	to	test	the	functionality	of	your	SCXI	module.	To	run	test
panels,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Expand	the	SCXI	chassis.	Right-click	the	module	you	want	to	test.
Select	Test	Panels	to	display	the	test	panel	for	the	module.
–or–
Select	the	module	you	want	to	test.	Click	Test	Panels	in	the	MAX
toolbar.
The	test	panel	appears.	You	can	view	the	available	tests	for	the
module	by	clicking	the	tabs	near	the	top	of	the	window.
Click	Help	for	more	details	about	using	the	test	panel.

3.	 If	a	problem	occurs	with	the	module,	the	Error	indicator	turns	red.
The	Error	Details	window	shows	detailed	information	about	the
error.

4.	 Click	Close	when	you	are	finished.



Resetting	SCXI	Modules
Resetting	an	SCXI	module	performs	a	hardware	reboot	of	the	module.
Complete	the	following	steps	to	reset	a	module:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Expand	the	chassis	containing	the	module.	Right-click	the	module
you	want	to	reset.	Select	Reset	Module.

3.	 An	explanatory	message	appears,	indicating	success	or	failure.
Click	OK	to	continue.



Removing	SCXI	Modules
To	remove	an	SCXI	module,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 In	the	configuration	tree,	right-click	the	module	you	want	to	delete.
3.	 Select	Delete.

You	also	can	delete	the	module	using	the	SCXI	Chassis	Configuration
window:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	SCXI	chassis	with	the	desired	module.	Select
Properties.

3.	 Select	None	from	the	Module	drop-down	listbox	for	the	slot	with
the	module	you	want	to	remove.

4.	 Click	OK	in	the	confirmation	dialog	box.
5.	 Click	OK	in	the	SCXI	Chassis	Configuration	window.



SCC	Devices
Refer	to	the	following	topics	for	more	information	on	SCC	connector
blocks	and	modules.



SCC	Connector	Block
Adding	an	SCC	Connector	Block
Configuring	an	SCC	Connector	Block
Removing	an	SCC	Connector	Block



SCC	Modules
Adding	SCC	Modules
Renaming	SCC	Modules
Removing	SCC	Modules



SCC	Connector	Block
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	SCC	connector	blocks.
Adding	an	SCC	Connector	Block
Configuring	an	SCC	Connector	Block
Removing	an	SCC	Connector	Block



Adding	an	SCC	Connector	Block
To	add	an	SCC	connector	block,	complete	the	following	steps:

1.	 Right-click	Devices	and	Interfaces.	Select	Create	New.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Devices	and
Interfaces.	Select	Create	New.

2.	 In	the	Create	New	window,	go	to	NI-DAQmx	Device»NI-DAQmx
SCC	Connector	Block.	Select	the	SCC	connector	block	you
want	to	add.

3.	 Click	Finish.
You	can	also	add	an	SCC	connector	block	without	using	the	Create	New
window.	Complete	the	following	steps:

1.	 Right-click	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Select	Create	New	DAQmx	Device»NI-DAQmx	SCC	Connector
Block.

3.	 Select	a	connector	block	from	the	list	of	available	SCC	connector
blocks.

In	the	SCC	Connector	Block	Configuration	window,	configure	your
settings.



Configuring	an	SCC	Connector	Block
To	configure	an	SCC	connector	block,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	SCC	connector	block	you	want	to	configure.	Select
Properties.

3.	 The	SCC	Connector	Block	Configuration	window	opens	with	the
following	configuration	settings:
	SCC	Carrier	Type	(SC-2345	only)
	Cabled	Device
	SCC	Connector	Block	ID
	Cabled	Device	Connector
	Scan	for	TEDS	(SC-2350	only)

4.	 Click	OK	when	you	are	finished.
Refer	to	Adding	SCC	Modules	for	more	information	on	adding	power
modules.



Removing	an	SCC	Connector	Block
To	remove	an	SCC	connector	block,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	connector	block	you	want	to	remove.	Select
Delete.
–or–
Select	the	connector	block	you	want	to	remove.	Click	Delete	in
the	MAX	toolbar.

Caution		This	action	also	removes	any	SCC	module	configuration	information	you	configured	in
the	selected	connector	block.



SCC	Modules
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	SCC	modules.
Adding	SCC	Modules
Renaming	SCC	Modules
Removing	SCC	Modules



Adding	SCC	Modules
Note		Before	you	add	an	SCC	module,	you	must	add	an	SCC	connector	block.

To	add	an	SCC	module,	complete	the	following	steps:
1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.

If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	SCC	connector	block	to	which	you	want	to	add	a
module.	Select	Properties.
–or–
Expand	the	SCC	connector	block	and	right-click	an	empty	slot.
Select	Insert.

3.	 In	the	SCC	Carrier	Configuration	window,	add	a	power	module	to
the	POWER	slot.	After	adding	a	power	module,	select	other
modules	you	want	to	add	from	the	drop-down	listbox	for	the
desired	slot.

4.	 Click	OK	when	you	are	finished.
You	can	also	rename	and	remove	SCC	modules.



Renaming	SCC	Modules
To	configure	SCC	modules,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices	in	the
configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Expand	the	SCC	connector	block.
3.	 Right-click	the	module	you	want	to	rename.	Select	Rename.
4.	 Type	a	descriptive	label	to	identify	the	module.	Use	only

alphanumeric	characters	for	the	name.	Do	not	use	punctuation	or
spaces.	Press	<Enter>	or	click	anywhere	on	the	screen	when
finished.



Removing	SCC	Modules
To	remove	an	SCC	module,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Expand	the	SCC	connector	block.	Right-click	the	module	you
want	to	delete.

3.	 Select	Delete.
–or–

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	SCC	connector	block	containing	the	module.
Select	Properties.

3.	 Select	None	for	the	desired	slot.



NI-DAQmx	Simulated	Devices
You	can	create	NI-DAQmx	simulated	devices	in	NI-DAQmx	7.4	or	later.
Using	NI-DAQmx	simulated	devices,	you	can	try	NI	products	in	your
application	without	the	hardware.	When	you	later	acquire	the	hardware,
you	can	import	the	NI-DAQmx	simulated	device	configuration	to	the
physical	device	using	the	MAX	Portable	Configuration	Wizard.	With	NI-
DAQmx	simulated	devices,	you	also	can	export	a	physical	device
configuration	onto	a	system	that	does	not	have	the	physical	device
installed.	Then,	using	the	NI-DAQmx	simulated	device,	you	can	work	on
your	applications	on	a	portable	system	and	upon	returning	to	the	original
system,	you	can	import	your	application.

Note		You	can	simulate	the	NI	cDAQ-9172,	but	you	cannot	import	or	export	the	configuration	of
this	device.

Note		NI-DAQmx	simulated	devices	cannot	be	included	in	the	same	task	with	physical	devices.

Refer	to	the	following	sections	for	details	about	creating,	importing,	and
removing	simulated	devices.
Creating	NI-DAQmx	Simulated	Devices
Importing	a	Physical	Device	as	an	NI-DAQmx	Simulated	Device
Importing	an	NI-DAQmx	Simulated	Device	Configuration	onto	a	Physical
Device
Removing	NI-DAQmx	Simulated	Devices



Creating	NI-DAQmx	Simulated	Devices
To	create	an	NI-DAQmx	simulated	device,	complete	the	following	steps:

1.	 Right-click	Devices	and	Interfaces	and	select	Create	New.
2.	 A	dialog	box	prompts	you	to	select	a	device	to	add.	Select	NI-

DAQmx	Simulated	Device	and	click	Finish.
3.	 In	the	Choose	Device	dialog	box,	select	the	category	of	devices

for	the	device	you	want	to	simulate.
4.	 Select	the	device	and	click	OK.	In	the	configuration	tree	in	MAX,

the	icons	for	NI-DAQmx	simulated	devices	are	yellow.
If	you	select	a	PXI	device,	you	are	prompted	to	select	a
chassis	number	and	PXI	slot	number.
If	you	select	an	SCXI	chassis,	the	SCXI	configuration
panels	open.
If	you	select	a	CompactDAQ	chassis,	you	must	right-click
the	empty	slots	to	add	C	Series	devices.

To	remove	an	NI-DAQmx	simulated	device,	right-click	the	device	and
click	Delete.



Importing	a	Physical	Device	as	an	NI-DAQmx	Simulated
Device
To	create	an	NI-DAQmx	simulated	device	for	a	physical	device,	use	the
Import	and	Export	feature	to	complete	the	following	steps:

1.	 Select	File»Export.
2.	 Select	the	physical	devices	you	want	to	create	an	NI-DAQmx

simulated	device	for.
3.	 Click	OK	to	create	a	.nce	file.
4.	 Select	File»Import	and	click	OK	to	import	the	.nce	file	created	in

the	previous	step.
If	you	have	a	physical	device	on	the	system	you	are
importing	to,	you	have	two	options.	You	can	overwrite	the
existing	physical	device	with	the	configuration	that	is	in	the
.nce	file.	You	also	can	import	the	NI-DAQmx	simulated
device	as	a	simulated	replica	of	the	physical	device	that	you
have	in	your	system.
If	you	do	not	have	a	physical	device	in	your	system,
completing	the	import	wizard	results	in	an	NI-DAQmx
simulated	version	of	the	device	that	is	in	the	configuration
.nce	file.



Importing	an	NI-DAQmx	Simulated	Device	Configuration
onto	a	Physical	Device
To	import	an	NI-DAQmx	simulated	device	configuration	onto	a	physical
device,	complete	the	following	steps:

1.	 Select	File»Export.
2.	 Select	the	NI-DAQmx	simulated	device	configuration	you	want	to

import	onto	a	physical	device.
3.	 Click	OK	to	create	an	.nce	file.
4.	 Select	File»Import	and	click	OK	to	import	the	.nce	file	created	in

the	previous	step.	If	you	have	a	physical	device	identical	to	the	NI-
DAQmx	simulated	device	you	exported,	you	can	import	your	NI-
DAQmx	simulated	device	configuration	onto	the	physical	device.

Note		You	must	have	the	same	physical	device	as	the	NI-DAQmx	simulated	device	for	the
import	feature	to	complete.



Removing	NI-DAQmx	Simulated	Devices
To	remove	an	NI-DAQmx	simulated	device,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
2.	 Right-click	the	NI-DAQmx	simulated	device	you	want	to	delete.

Note		In	the	configuration	tree	in	MAX,	the	icons	for	NI-
DAQmx	simulated	devices	are	yellow.	The	icons	for
physical	devices	are	green.

3.	 Click	Delete.



Configuring	Switch	Modules
To	configure	a	switch	module,	complete	the	following	steps:

1.	 In	the	configuration	tree,	right-click	the	module	you	want	to
configure	and	select	Properties.	For	SCXI	switches,	you	also	can
configure	the	switch	module	by	opening	the	SCXI	Chassis
Configuration	window	and	clicking	Details	next	to	the	desired
switch.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	the	chassis.	Right-click
the	switch	module	you	want	to	configure	and	select	Properties.
The	Module	Configuration	window	opens	with	the	following	tabs:
	Terminal	Block/Topology	Settings
	Channels	Settings

2.	 Click	OK	in	the	Module	Configuration	window	when	you	are
finished.

Note		If	you	make	changes	in	the	property	pages	of	the	device,	the	device	automatically	resets
when	you	click	the	OK	button.	Changes	cannot	take	effect	until	a	reset	occurs.

3.	 For	SCXI	switch	modules,	click	OK	in	the	SCXI	Chassis
Configuration	window.



TEDS	Carrier
Refer	to	the	following	topics	for	more	information	on	adding,	configuring,
and	removing	TEDS	carriers.
Adding	a	TEDS	Carrier
Configuring	a	TEDS	Carrier
Removing	a	TEDS	Carrier



Adding	a	TEDS	Carrier
To	add	a	TEDS	carrier,	complete	the	following	steps:

1.	 Right-click	Devices	and	Interfaces.	Select	Create	New.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Devices	and
Interfaces.	Select	Create	New.

2.	 In	the	Create	New	window,	select	NI-DAQmx	Device»NI-DAQmx
TEDS	Interface.	Select	a	carrier.

3.	 Click	Finish.
You	can	also	add	a	TEDS	carrier	without	using	the	Create	New	window.
Complete	the	following	steps:

1.	 Right-click	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Select	Create	New	DAQmx	Device»NI-DAQmx	TEDS	Interface.
3.	 Select	a	carrier.

In	the	carrier	configuration	window,	configure	your	settings.



Configuring	a	TEDS	Carrier
To	configure	a	TEDS	carrier,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	TEDS	carrier	you	want	to	configure.	Select
Properties.

3.	 The	TEDS	carrier	configuration	window	opens	with	the	following
configuration	settings:
	Channels
	Device
	Carrier	ID
	2096	Address
	Scan	for	TEDS

4.	 Click	OK	when	you	are	finished.



Removing	a	TEDS	Carrier
To	remove	a	TEDS	carrier,	complete	the	following	steps:

1.	 Expand	Devices	and	Interfaces»NI-DAQmx	Devices.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	expand	Devices	and
Interfaces»NI-DAQmx	Devices.

2.	 Right-click	the	TEDS	carrier	you	want	to	remove.	Select	Delete.
–or–
Select	the	TEDS	carrier	you	want	to	remove.	Click	Delete	in	the
MAX	toolbar.



Creating	Tasks	and	Global	Virtual	Channels
You	can	set	up	global	virtual	channels	and	tasks	in	MAX	using	the	DAQ
Assistant.	To	create	a	task	or	global	virtual	channel,	complete	the
following	steps:

1.	 Right-click	Data	Neighborhood	in	the	configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Data	Neighborhood
in	the	configuration	tree.

2.	 Select	Create	New.
3.	 Select	either	NI-DAQmx	Task	or	NI-DAQmx	Global	Virtual

Channel.
4.	 Click	Next.	The	DAQ	Assistant	opens.

For	more	information	on	creating	tasks	and	virtual	channels,	refer	to	the
DAQ	Assistant	Help.	If	you	are	using	LabVIEW,	refer	to	Taking	an	NI-
DAQmx	Measurement	in	LabVIEW	to	learn	how	to	create	a	task.
You	also	can	generate	code	from	your	task	or	virtual	channel	if	you	are
using	version	7.x	or	later	of	LabVIEW,	LabWindows/CVI,	or	Measurement
Studio,	or	version	7.1	or	later	of	the	LabVIEW	Real-Time	Module.	If	you
want	to	generate	code,	you	must	access	your	task	or	virtual	channel	from
your	ADE.	Refer	to	the	NI-DAQmx	Help	and	your	application	software
documentation	for	more	information	on	programming	with	your	task	or
virtual	channel.



Duplicating	NI-DAQmx	Global	Virtual	Channels
To	duplicate	a	virtual	channel,	complete	the	following	steps:

1.	 Expand	Data	Neighborhood.
2.	 Expand	NI-DAQmx	Global	Virtual	Channels.
3.	 Right-click	the	global	virtual	channel	you	want	to	duplicate.
4.	 Select	Duplicate.
5.	 A	dialog	box	prompts	you	to	select	physical	channels	from	a	list	of

valid	physical	channels	for	the	measurement	type.	Select	the
physical	channels	to	use	in	the	new	global	virtual	channels.	A	new
name	is	generated	for	each	new	global	virtual	channel,	consisting
of	the	original	name	with	an	incremented	number	appended	to	the
end.

6.	 Click	OK.
Note		Downgrading	to	NI-DAQmx	7.3	or	earlier	can	cause	problems	with	task	and	channel
information	programmatically	saved	to	MAX.	Before	downgrading,	open	the	programmatically
saved	task	or	global	virtual	channel	in	MAX	and	re-save	it.	To	save	the	global	virtual	channel	or
task	after	you	have	loaded	it,	you	must	modify	the	channel	or	task.	Then,	the	dialog	prompts
you	to	save	the	channel.



Creating	Scales
You	can	set	up	scales	in	MAX	using	the	DAQ	Assistant.	To	create	a	new
scale,	complete	the	following	steps:

1.	 Right-click	Scales	in	the	configuration	tree.
If	you	are	using	a	remote	RT	target,	expand	Remote	Systems,
find	and	expand	your	target,	and	right-click	Scales.

2.	 Select	Create	New.
3.	 Select	NI-DAQmx	Scale.
4.	 Click	Next.	The	DAQ	Assistant	opens.

For	more	information	on	creating	scales,	refer	to	the	DAQ	Assistant	Help.



Importing	and	Exporting	Configurations
In	MAX,	you	can	save	virtual	channels,	tasks,	scales,	and	devices	for
reuse	on	other	systems	also	running	MAX.	Use	the	Export	Configuration
Wizard	in	MAX	to	save	a	configuration.	Use	the	Import	Configuration
Wizard	in	MAX	to	load	a	previously	saved	configuration.	NI-DAQmx
supports	three	import/export	file	formats:

NI	Configuration	Export	File	(.nce)
NI-DAQmx	INI	File	(.ini)
NI-DAQmx	Tab-Delimited	Text	(.txt)
Note		You	can	also	programmatically	import	and	export	configuration	files.	For	more
information,	refer	to	the	MAX	Configuration	VI	Reference	for	LabVIEW,	the	MAX	Configuration
Function	Reference	for	LabWindows/CVI,	or	the	MAX	Configuration	Function	Reference	for
Measurement	Studio.

Note		MAX	cannot	import/export	TEDS	sensor	information.

Caution		Importing	a	new	device	configuration	with	the	same	name	as	an	existing	device
configuration	overwrites	the	current	device	configuration.	Overwriting	the	current	configuration
breaks	all	dependencies	with	associated	devices,	channels,	and	tasks.

javascript:LaunchHelp(L_nipcHelpchm, 'export.html')
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NI	Configuration	Export	Files
NI	Configuration	Export	Files	(.nce)	are	binary	files	that	can	contain
tasks,	channels,	scales,	and	device	configuration.	Use	.nce	files	if	you
want	to	import	and	export	complete	configurations	and	you	do	not	need
to	edit	that	configuration	outside	of	MAX.



NI-DAQmx	INI	Files
NI-DAQmx	INI	files	are	text	files	that	can	contain	tasks,	channels,	and
scales,	but	not	device	configuration.	To	import/export	device
configurations,	use	.nce	files.	Use	.ini	files	if	you	want	to	import	and
export	configurations	using	a	text	format	that	you	can	edit	outside	of
MAX.
NI-DAQmx	INI	files	must	start	with	a	heading	that	includes	the	major	and
minor	version	numbers	for	the	version	of	NI-DAQmx	you	want	to	export
from	or	import	to.
The	INI	file	consists	of	entries	for	tasks,	channels,	and	scales.	Each	entry
starts	with	the	type	of	object	and	the	name	of	the	object,	enclosed	in
brackets.	The	possible	object	types	are	DAQmxTask,	DAQmxChannel,
and	DAQmxScale.
Each	entry	then	consists	of	property/value	pairs	in	the	form	property	=
value.
You	can	use	any	combination	of	English	LabVIEW	long	and	short
property	names,	CVI	property	names,	and	C++/.NET	class.property
names.
To	indicate	that	a	channel	is	a	local	channel,	include	the	task	name	and	a
forward	slash	before	the	channel	name,	both	in	the	entry	for	the	channel
and	in	the	Channels	property	for	the	task.	The	task	name	is	required
because	two	tasks	can	have	a	local	channel	with	the	same	name.
To	add	comments	to	an	NI-DAQmx	INI	file,	start	the	line	with	a
semicolon.
For	more	examples	of	specific	configurations,	create	tasks,	channels,
and	custom	scales	in	the	DAQ	Assistant,	then	export	the	configuration	to
an	NI-DAQmx	INI	file.



NI-DAQmx	Tab-Delimited	Text
NI-DAQmx	tab-delimited	text	files	can	contain	tasks,	channels,	and
scales,	but	not	device	configuration.	To	import/export	device
configurations,	use	.nce	files.	Use	NI-DAQmx	tab-delimited	text	files	if
you	want	to	import	and	export	configurations	using	a	text	format	also
suitable	for	editing	as	a	spreadsheet.
NI-DAQmx	tab-delimited	text	files	consist	of	a	table	for	each	object	type,
with	each	column	in	a	table	separated	by	a	tab.	The	first	table	must
include	the	major	and	minor	version	numbers	for	the	version	of	NI-
DAQmx	you	want	to	export	from	or	import	to.
The	first	row	of	a	table	describes	the	structure	of	the	table.	The	first
column	in	that	row	specifies	the	type	of	object	in	the	table.	The	possible
object	types	are	DAQmxTasks,	DAQmxChannels,	and	DAQmxScales.
Each	subsequent	column	specifies	the	name	of	the	property	to	set	in	the
following	rows.	You	can	use	any	combination	of	English	LabVIEW	long
and	short	property	names,	CVI	property	names,	and	C++/.NET
class.property	names.
The	remaining	rows	specify	property	settings	for	the	objects.	The	name
of	the	object	must	be	in	the	same	column	as	the	object	type.	If	a	property
is	not	needed	for	an	object,	leave	the	column	blank.	You	can	include
multiple	objects	of	the	same	type	in	a	single	table	or	divide	the	objects
among	multiple	tables.
To	indicate	that	a	channel	is	a	local	channel,	include	the	task	name	and	a
forward	slash	before	the	channel	name,	both	in	the	entry	for	the	channel
and	in	the	Channels	property	for	the	task.	The	task	name	is	required
because	two	tasks	can	have	a	local	channel	with	the	same	name.
For	more	examples	of	specific	configurations,	create	tasks,	channels,
and	custom	scales	in	the	DAQ	Assistant,	then	export	the	configuration	to
an	NI-DAQmx	tab-delimited	text	file.



Reassigning	Device	Names	to	Default	Values
Reassigning	device	names	to	default	values	restores	the	software-
assigned	name	for	each	device.
To	reassign	device	names,	complete	the	following	steps:

1.	 Select	Tools»NI-DAQmx	Configuration»Reassign	Device
Names	to	Default	Values.

2.	 Select	either	a	Local	or	Remote	configuration	from	the	pull-down
list.	If	you	select	a	remote	configuration,	then	enter	an	IP	address
and	click	OK.	Click	Cancel	to	exit.



MAX	Report	Generation
Use	the	MAX	Report	Wizard	to	generate	a	report	of	the	NI-DAQmx
hardware	and	software	configuration	of	the	system.	The	report	includes
the	following:

Real	and	simulated	device	information,	including	device	name,
device	type,	serial	number,	connected	accessory,	and	other
settings
Task	information,	including	channels,	timing,	triggering,	and	other
property	settings
Global	virtual	channel	property	settings
Custom	scale	property	settings

The	MAX	Report	Wizard	supports	both	local	and	remote	systems.
Note		You	can	also	programmatically	generate	a	system	report.	For	more	information,	refer	to
the	MAX	Configuration	VI	Reference	for	LabVIEW,	the	MAX	Configuration	Function	Reference
for	LabWindows/CVI,	or	the	MAX	Configuration	Function	Reference	forMeasurement	Studio.
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Resetting	an	NI-DAQmx	Configuration
Resetting	a	configuration	restores	the	configuration	to	a	baseline
condition.	Entries	for	channels,	tasks,	scales,	SCXI	chassis,	SCC
modules,	and	accessories	are	deleted.	MAX	still	lists	DAQ	devices,	but
resets	any	user	settings.
To	reset	a	configuration,	complete	the	following	steps:

1.	 Select	Tools»NI-DAQmx	Configuration»Reset	NI-DAQmx
Configuration.

2.	 Select	either	a	Local	or	Remote	configuration	from	the	pull-down
list.	If	you	select	a	remote	configuration,	then	enter	an	IP	address
and	click	OK.	Click	Cancel	to	exit.



Operating	System	Considerations
Special	considerations	exist	for	the	following	operating	systems:
Windows	2000/XP



Special	Considerations	for	Windows	2000/XP
The	Windows	2000/XP	Device	Manager	manages	all	hardware	devices
that	you	have	in	your	computer	system.	However,	the	Windows	2000/XP
operating	system	might	not	automatically	detect	all	DAQ	devices.	For
information	on	adding	or	configuring	specific	DAQ	devices,	refer	to	the
following	topics:
Plug	and	Play	Devices
PCI,	PCMCIA,	and	PXI	Devices
Windows	2000/XP	Device	Manager



Plug	and	Play	Devices	in	Windows	2000/XP
If	MAX	did	not	automatically	detect	the	device,	complete	the	following
steps:

1.	 In	Windows	2000/XP,	go	to	Start»Settings»Control
Panel»System,	and	select	the	Hardware	tab.	Click	Device
Manager.

2.	 Select	a	National	Instruments	DAQ	device	under	Other	Devices
in	the	device	type	list.	Right-click	the	device,	and	select	Uninstall.
Repeat	with	each	NI	device	in	the	list.

3.	 Right-click	in	the	Device	Manager	window,	and	select	Scan	for
hardware	changes.	Windows	2000/XP	detects	Plug	and	Play
device(s).

4.	 Click	OK	when	you	are	finished.
If	you	have	not	yet	installed	the	Plug	and	Play	DAQ	device,	power	off
your	computer	and	install	the	device.	Power	on	the	computer	after
installation	is	complete.	When	Windows	2000/XP	starts	up,	it	should
assign	resources	to	the	device	automatically.
If	Windows	2000/XP	does	not	detect	the	Plug	and	Play	device,	refer	to
ni.com/support	for	troubleshooting	help.
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PCI,	PCMCIA,	and	PXI	Devices	in	Windows	2000/XP
PCI,	PCMCIA,	and	PXI	DAQ	devices	are	Plug	and	Play	devices.
Generally,	you	cannot	modify	any	system	resources	for	PCI,	PCMCIA,
and	PXI	DAQ	devices.	In	Windows	2000/XP,	you	can	modify	the	Memory
Window	only	by	using	the	Device	Manager.



Windows	2000/XP	Device	Manager
The	Device	Manager	allocates	system	resources	for	all	the	devices	that
you	have	in	the	system	and	makes	sure	that	no	two	devices	are	using
incompatible	system	resources,	such	as	the	same	base	address.
In	Windows	2000/XP,	open	the	Device	Manager	by	going	to
Start»Settings»Control	Panel,	double-clicking	the	System	icon,
selecting	the	Hardware	tab,	and	clicking	Device	Manager.
If	you	have	a	Plug	and	Play	device,	the	Device	Manager	detects	the
device	when	the	system	starts	and	automatically	assigns	resources	for
the	device.	For	more	information,	refer	to	Plug	and	Play	Devices	in
Windows	2000/XP.



Glossary
Prefixes 	 Numbers/Symbols 	 A 	 B 	 C 	 D 	 E 	 F 	 G 	 H 	 I 	

J 	 L 	 M 	 N 	 O 	 P 	 R 	 S 	 T 	 U 	 V 	 W

Symbol Prefix Value
n nano 10	-9

µ micro 10	-6

m milli 10	-3

k kilo 10	3

M mega 10	6

Symbol Meaning
% percent
+ positive	of,	or	plus
– negative	of,	or	minus
Ω ohm
º degree



A
acceleration A	change	in	velocity	with	respect	to	time.
accelerometer A	sensor	that	represents	acceleration	as	a	voltage.
ADC Analog-to-digital	converter—an	electronic	device,	often

an	integrated	circuit,	that	converts	an	analog	signal	to	a
digital	value.

address A	character	code	that	identifies	a	specific	location	(or
series	of	locations)	in	memory.

ADE Application	development	environment—some	examples
include	LabVIEW	and	LabWindows/CVI.

AI Analog	input—acquisition	of	data.
amplification A	type	of	signal	conditioning	that	improves	accuracy	in

the	resulting	digitized	signal	by	increasing	signal
amplitude	relative	to	noise.

analog Data	represented	by	continuously	variable	physical
quantities.

AO Analog	output—generation	of	data.
angular
displacement

Movement	about	an	axis,	such	as	the	angular	motion	of
the	shaft	of	a	motor.

angular
displacement
sensor

A	device	whose	output	signal	represents	the	rotation	of
the	shaft,	such	as	a	rotary	variable	differential
transformer	(RVDT).

API Application	programming	interface—A	library	of
functions,	classes	or	VIs,	attributes,	and	properties	for
creating	applications	for	your	device.

asynchronous 1.	 Hardware—a	signal	that	occurs	or	is	acted	upon
at	an	arbitrary	time,	without	synchronization	to
another	signal,	such	as	a	reference	clock.

2.	 Software—a	VI	or	function	that	begins	an
operation	and	returns	prior	to	the	completion	or
termination	of	the	operation.



attenuation The	reduction	of	a	voltage	or	acoustical	pressure.
Measured	referenced	to	the	original	voltage.



B
bandwidth The	range	of	frequencies	present	in	a	signal,	or	the	range	of

frequencies	to	which	a	measuring	device	can	respond.
base
address

A	memory	address	that	serves	as	the	starting	address	for
programmable	registers.	All	other	addresses	are	located	by
adding	to	the	base	address.

bipolar A	signal	range	that	includes	both	positive	and	negative
values	(for	example,	​5	V	to	+5	V).

BIOS Basic	Input/Output	System—BIOS	functions	are	the
fundamental	level	of	any	PC	or	compatible	computer.	BIOS
functions	embody	the	basic	operations	needed	for
successful	use	of	the	computer	hardware	resources.

bit The	smallest	unit	of	data	used	in	a	digital	operation.	Bits	are
binary,	so	they	can	be	either	a	1	or	a	0.

buffer In	software,	temporary	storage	for	acquired	or	to-be-
generated	samples.

bus The	group	of	conductors	that	interconnect	individual	circuitry
in	a	computer.	Typically,	a	bus	is	the	expansion	vehicle	to
which	I/O	or	other	devices	are	connected.	Examples	of	PC
buses	are	the	ISA	bus	and	PCI	bus.



C
C	Series A	family	of	devices	or	modules	used	for	analog	input,

analog	output,	digital	input/output,	and	counter/timer
applications.	C	Series	devices	work	with	chassis	based
on	the	CompactDAQ,	CompactRIO,	and	other
architectures,	and	are	components	of	the	NI	USB-9XXX
devices.

cDAQ The	prefix	of	the	product	model	name	of	a	CompactDAQ
device,	such	as	NI	cDAQ-9172.

CH Channel.
channel 1.	 Physical—a	terminal	or	pin	at	which	you	can

measure	or	generate	an	analog	or	digital	signal.	A
single	physical	channel	can	include	more	than
one	terminal,	as	in	the	case	of	a	differential
analog	input	channel	or	a	digital	port	of	eight
lines.	The	name	used	for	a	counter	physical
channel	is	an	exception	because	that	physical
channel	name	is	not	the	name	of	the	terminal
where	the	counter	measures	or	generates	the
digital	signal.

2.	 Virtual—a	collection	of	property	settings	that	can
include	a	name,	a	physical	channel,	input	terminal
connections,	the	type	of	measurement	or
generation,	and	scaling	information.	You	can
define	NI-DAQmx	virtual	channels	outside	a	task
(global)	or	inside	a	task	(local).	Configuring	virtual
channels	is	optional	in	Traditional	NI-DAQ
(Legacy)	and	earlier	versions,	but	is	integral	to
every	measurement	you	take	in	NI-DAQmx.	In
Traditional	NI-DAQ	(Legacy),	you	configure	virtual
channels	in	MAX.	In	NI-DAQmx,	you	can
configure	virtual	channels	either	in	MAX	or	in	a
program,	and	you	can	configure	channels	as	part
of	a	task	or	separately.



3.	 Switch—a	switch	channel	represents	any
connection	point	on	a	switch.	It	may	be	made	up
of	one	or	more	signal	wires	(commonly	one,	two,
or	four),	depending	on	the	switch	topology.	A
virtual	channel	cannot	be	created	with	a	switch
channel.	Switch	channels	may	be	used	only	in	the
NI-DAQmx	Switch	functions	and	VIs.

clock A	periodic	digital	signal.
CMRR Common-mode	rejection	ratio—a	measure	of	the	ability

of	an	instrument	to	reject	interference	from	a	common-
mode	signal,	usually	expressed	in	decibels	(dB).

code	width The	smallest	detectable	change	in	an	input	voltage	of	a
DAQ	device.

cold-junction
compensation

A	method	of	compensating	for	inaccuracies	in
thermocouple	circuits.

CompactDAQ An	architecture	or	chassis	for	C	Series	devices.
configuration
tree

Refers	to	the	left	window	in	MAX,	which	contains	items
such	as	Data	Neighborhood	and	Devices	and	Interfaces.

counter/timer A	circuit	that	counts	digital	edges.	Counters	and	timers
usually	have	from	16	bits	to	48	bits	(sometimes	more)
counting	capability.	The	total	number	of	counts	possible
equals	2N,	where	N	is	the	number	of	bits	in	the	counter.
When	the	edges	counted	are	produced	by	a	clock,
elapsed	time	can	be	computed	from	the	number	of	edges
counted	if	the	clock	frequency	is	known.

convert	clock The	clock	on	a	multiplexed	device	that	directly	causes
ADC	conversions.

custom	scale A	method	of	instructing	NI-DAQmx	to	apply	additional
scaling	to	your	data.	Refer	to	the	Create	Scale
function/VI	in	your	reference	help.



D
DAC Digital-to-analog	converter—an	electronic	device,	often	an

integrated	circuit,	that	converts	a	digital	value	into	a
corresponding	analog	voltage	or	current.

DAQ Refer	to	data	acquisition.
DAQ
Assistant

A	graphical	interface	for	configuring	measurement	tasks,
virtual	channels,	and	scales.

DAQ	device A	device	that	acquires	or	generates	data	and	can	contain
multiple	channels	and	conversion	devices.	DAQ	devices
include	plug-in	devices,	PCMCIA	cards,	and	DAQPad
devices,	which	connect	to	a	computer	USB	or	1394
(FireWire)	port.	SCXI	modules	are	considered	DAQ
devices.

data Samples.
data
acquisition
(DAQ)

1.	 Acquiring	and	measuring	analog	or	digital	electrical
signals	from	sensors,	transducers,	and	test	probes
or	fixtures.

2.	 Generating	analog	or	digital	electrical	signals.

dB Decibel—the	unit	for	expressing	a	logarithmic	measure	of
the	ratio	of	two	signal	levels:	dB=20log10	V1/V2,	for
signals	in	volts.

DC direct	current
delay	from
sample

The	amount	of	time	to	wait	after	receiving	a	sample	clock
edge	before	beginning	the	acquisition	of	a	sample.

delay	from
start

The	amount	of	time	to	wait	after	receiving	a	Start	Trigger
before	beginning	the	operation.

determinism Characteristic	of	a	system	that	describes	how	consistently
it	can	respond	to	external	events	or	perform	operations
within	a	given	time	limit.

device 1.	 An	instrument	or	controller	you	can	access	as	a
single	entity	that	controls	or	monitors	real-world	I/O



points.	A	device	often	is	connected	to	a	host
computer	through	some	type	of	communication
network.

2.	 See	also	DAQ	device	and	measurement	device.

digital A	TTL	signal.	Refer	to	edge.
DIO digital	input/output
DMA direct	memory	access—A	method	of	transferring	data

between	a	buffer	and	a	device	that	is	used	most	often	for
high-speed	operations.

driver Software	unique	to	the	device	or	type	of	device,	and
includes	the	set	of	commands	the	device	accepts.

drop-down
listbox

A	graphical	box	with	a	down	arrow	button	that	lets	you
select	values	or	options	from	a	list.	To	select	a	value	or
option	in	the	selection	box,	click	the	down	arrow	for	a
complete	list	of	values	or	options,	then	use	your	arrow
keys	or	mouse	to	select	a	value	or	option	from	the	list.

DSUB D-subminiature	connector
DUT device	under	test—a	device	used	for	testing	purposes.



E
E	Series A	standard	architecture	for	instrumentation-class,

multichannel	data	acquisition	devices.
edge A	digital	edge	is	a	single	rising	or	falling	TTL	transition.	An

analog	edge	is	defined	by	the	slope,	level,	and	hysteresis
settings.

event A	digital	signal	produced	from	a	device	or	circuit.	For	an
advanced	discussion	of	events,	refer	to	Events.

excitation Supplying	a	voltage	or	current	source	to	energize	a	sensor	or
circuit.

mxcncpts.chm::/Events.html


F
fall	time The	time	for	a	signal	to	transition	from	90%	to	10%	of	the

maximum	signal	amplitude.
filtering A	type	of	signal	conditioning	that	you	can	use	to	remove

unwanted	frequency	components	from	the	signal	you	are
measuring.

FIFO A	type	of	memory	that	implements	a	First	In	First	Out	strategy
in	which	samples	are	removed	in	the	order	they	were	written.
FIFOs	are	typically	used	as	intermediate	buffers	between	an
ADC	or	DAC	and	the	memory	buffer.

floating
signal
sources

Signal	sources	with	voltage	signals	that	are	not	connected	to
an	absolute	reference	or	system	ground.



G
gain The	factor	by	which	a	signal	is	amplified,	often	expressed	in

decibels	(dB).	Gain	as	a	function	of	frequency	is	commonly
referred	to	as	the	magnitude	of	the	frequency	response
function.

grounded
signal
sources

Signal	sources	with	voltage	signals	that	are	referenced	to	a
system	ground,	such	as	the	earth	or	a	building	ground.
Grounded	signal	sources	are	also	called	referenced	signal
sources.



H
hardware The	physical	components	of	a	computer	system,	such	as	the

circuit	boards,	plug-in	boards,	chassis,	enclosures,
peripherals,	and	cables.

hardware
timing

A	means	of	controlling	signal	generation.	A	digital	signal,
such	as	a	clock	on	a	DAQ	device,	controls	the	rate	of
generation.

hardware
triggering

A	form	of	triggering	in	which	the	source	of	the	trigger	is	an
analog	or	digital	signal.	Refer	to	Software	Trigger.

hex Hexadecimal—a	base-16	numbering	system.
hysteresis A	window	around	a	trigger	level	that	is	often	used	to	reduce

false	triggering	due	to	noise	or	jitter	in	the	signal.
Hz Hertz—cycles	per	second	of	a	periodic	signal.



I
IEEE
P1451

Family	of	IEEE	standards	defining	a	variety	of	smart
transducer	interfaces.	All	of	the	standards	within	this	family
support	the	concept	of	a	TEDS	that	provides	self-
identification	and	plug	and	play	operation	to	transducers.

IEEE
P1451.4

An	IEEE	standard	that	defines	the	concept	of	plug	and	play
sensors	with	analog	signals.	This	is	accomplished	with	the
addition	of	a	TEDS	in	memory,	typically	an	EEPROM,
embedded	within	the	sensor	and	communicated	through	a
simple,	low-cost	serial	connection.

instrument
driver

Refer	to	driver.

interrupt A	method	whereby	a	device	notifies	the	computer	of	some
condition	on	the	device	that	requires	the	computer's
attention.	When	this	condition	is	a	request	for	data	or	a
notification	of	available	data,	interrupts	are	used	as	a	data
transfer	mechanism.

interrupt
level

The	relative	priority	at	which	a	device	can	interrupt.

I/O Input/Output—the	transfer	of	data	to/from	a	computer
system	involving	communications	channels,	operator
interface	devices,	and/or	data	acquisition	and	control
interfaces.

IRQ Interrupt	ReQuest.
ISA Industry	Standard	Architecture—Also	refers	to	a	common

PC	expansion	bus.
isolation A	type	of	signal	conditioning	in	which	you	isolate	the

transducer	signals	from	the	computer.	Isolation	makes	sure
the	measurements	from	the	measurement	device	are	not
affected	by	differences	in	ground	potentials.



J
jitter The	amount	of	time	that	the	loop	cycle	time	varies	from	the	desired

time.



L
LED light-emitting	diode—a	semiconductor	light	source.
line An	individual	signal	in	a	digital	port.	The	difference

between	a	bit	and	a	line	is	that	the	bit	refers	to	the	actual
data	transferred,	and	the	line	refers	to	the	hardware	the
bit	is	transferred	on.	However,	the	terms	line	and	bit	are
fairly	interchangeable.	For	example,	an	8-bit	port	is	the
same	as	a	port	with	eight	lines.

linear
displacement

Movement	in	one	direction	along	a	single	axis.

linear
displacement
sensor

A	device	that	measures	linear	displacement.

linearization A	type	of	signal	conditioning	in	which	software	linearizes
the	voltage	levels	from	transducers,	so	the	voltages	can
be	scaled	to	measure	physical	phenomena.

LSB least	significant	bit—often	used	to	refer	to	the	smallest
voltage	change	detectable	by	an	A/D	converter	or	the
smallest	voltage	change	that	can	be	generated	by	a	D/A
converter.

LVDT Linear-voltage	differential	transformer—A	sensor	used	to
measure	linear	displacement.	An	LVDT	consists	of	a
passive	transform	with	one	primary	and	two	secondary
windings.	The	primary	winding	is	excited	by	an	audio
frequency	range	AC	voltage,	whose	imbalance	between
the	secondary	windings,	is	proportional	to	the
displacement.	The	secondary	windings	are	identical,	but
are	normally	connected	with	opposite	polarity,	so	the
transducer	at	resting	position	will	have	zero	output
voltage.



M
M	Series A	standard	architecture	for	instrumentation-class,

multichannel	data	acquisition	devices.
MAX Measurement	&	Automation	Explorer—A	centralized

configuration	environment	that	allows	you	to	configure	all
of	your	National	Instruments	devices.

measurement
device

DAQ	devices	such	as	the	M	Series	multifunction	I/O
(MIO)	devices,	SCXI	signal	conditioning	modules,	and
switch	modules.

memory
buffer

Refer	to	buffer.

memory
mapping

A	technique	for	reading	and	writing	to	a	device	directly
from	your	program,	which	avoids	the	overhead	of
delegating	the	reads	and	writes	to	kernel-level	software.
Delegation	to	the	kernel	is	safer,	but	slower.	Memory
mapping	is	less	safe	because	an	entire	4	KB	page	of
memory	must	be	exposed	to	your	program	for	this	to
work,	but	it	is	faster.

microphone A	transducer	that	converts	acoustical	waves	into
electrical	signals.

MIO multifunction	I/O—Designates	a	category	of	data
acquisition	devices	that	have	multiple	analog	input
channels,	digital	I/O	channels,	timing,	and	optionally,
analog	output	channels.	An	MIO	product	can	be
considered	a	miniature	mixed	signal	tester,	due	to	its
broad	range	of	signal	types	and	flexibility.	It	is	also
known	as	multifunction	DAQ.	An	E	Series	device	is	an
example	of	an	MIO	device.

module A	board	assembly	and	its	associated	mechanical	parts,
front	panel,	optional	shields,	and	so	on.	A	module
contains	everything	required	to	occupy	one	or	more	slots
in	a	mainframe.	SCXI	and	PXI	devices	are	modules.

multiplexed An	SCXI	operating	mode	in	which	analog	input	channels



mode are	multiplexed	into	one	module	output	so	that	the
cabled	DAQ	device	has	access	to	the	multiplexed	output
as	well	as	the	outputs	on	all	other	multiplexed	modules	in
the	chassis	through	the	SCXI	bus.	Also	called	serial
mode.

multiplexer A	switching	device	with	multiple	terminals	that
sequentially	connects	each	of	its	terminals	to	a	single
terminal,	typically	at	high	speeds.	Often	used	to	measure
several	signals	with	a	single	analog	input	channel.

multithreading Running	tasks	of	an	application	for	a	short	amount	of
time	to	give	the	impression	of	multiple	tasks	running
simultaneously.



N
NI-DAQ Driver	software	included	with	all	NI	measurement	devices.

NI-DAQ	is	an	extensive	library	of	VIs	and	functions	you	can
call	from	an	application	development	environment	(ADE),
such	as	LabVIEW,	to	program	all	the	features	of	an	NI
measurement	device,	such	as	configuring,	acquiring	and
generating	data	from,	and	sending	data	to	the	device.

NI-DAQ	7.x Includes	two	NI-DAQ	drivers—NI-DAQmx	and	Traditional
NI-DAQ	(Legacy)—each	with	its	own	API,	hardware
configuration,	and	software	configuration.

NI-DAQmx The	latest	NI-DAQ	driver	with	new	VIs,	functions,	and
development	tools	for	controlling	measurement	devices.
The	advantages	of	NI-DAQmx	over	earlier	versions	of	NI-
DAQ	include	the	DAQ	Assistant	for	configuring	channels
and	measurement	tasks	for	your	device	for	use	in
LabVIEW,	LabWindows/CVI,	and	Measurement	Studio;
increased	performance	such	as	faster	single-point	analog
I/O;	and	a	simpler	API	for	creating	DAQ	applications	using
fewer	functions	and	VIs	than	earlier	versions	of	NI-DAQ.

NI-DAQmx
Simulated
Device

A	replica	of	a	device	created	using	the	NI-DAQmx
Simulated	Device	option	in	the	Create	New	menu	of	MAX
for	the	purpose	of	operating	a	function	or	program	without
hardware.	An	NI-DAQmx	simulated	device	behaves
similarly	to	a	physical	device.	Its	driver	is	loaded,	and
programs	using	it	are	fully	verified.

nonlinearity A	measure	in	percentage	of	full-scale	range	(FSR)	of	the
worst-case	deviation	from	the	ideal	transfer	function—a
straight	line.
This	specification	is	included	only	for	DAQ	products,	such
as	signal	conditioning	products,	that	do	not	have	an	ADC.
Because	a	product	with	this	specification	can	also	be	used
with	a	DAQ	product	with	an	ADC,	this	nonlinearity
specification	must	be	added	to	the	relative	accuracy
specification	of	the	DAQ	product	with	the	ADC.



NRSE Nonreferenced	single-ended	mode—all	measurements	are
made	with	respect	to	a	common	(NRSE)	measurement
system	reference,	but	the	voltage	at	this	reference	can	vary
with	respect	to	the	measurement	system	ground.



O
onboard Provided	by	the	data	acquisition	device.
onboard
channels

Channels	provided	by	the	plug-in	data	acquisition	device.

onboard
clock

The	default	source	for	a	particular	clock.	Usually,	the	device
has	dedicated	a	circuit	for	producing	this	signal	and	its	only
purpose	is	to	act	as	the	source	for	a	certain	clock.

onboard
memory

Memory	provided	by	a	device	for	temporary	storage	of	input
or	output	data.	Typically,	onboard	memory	is	a	FIFO,	which	is
distinct	from	computer	memory.

operating
system

Base-level	software	that	controls	a	computer,	runs	programs,
interacts	with	users,	and	communicates	with	installed
hardware	or	peripheral	devices.	Also	referred	to	as	OS.



P
parallel
mode

A	type	of	SCXI	operating	mode	in	which	the	module	sends
each	of	its	input	channels	directly	to	a	separate	analog
input	channel	of	the	device	connected	to	the	module.

pattern	I/O pattern	input	and	output—a	digital	I/O	operation	on	which
a	clock	signal	initiates	a	digital	transfer.	Because	the	clock
signal	is	a	constant	frequency,	you	can	generate	and
receive	patterns	at	a	constant	rate.

PCI peripheral	component	interconnect—a	high-performance
expansion	bus	architecture	originally	developed	by	Intel	to
replace	ISA	and	EISA.	PCI	has	achieved	widespread
acceptance	as	a	standard	for	PCs	and	work	stations,	and
it	offers	a	theoretical	maximum	transfer	rate	of	132
Mbytes/s.

PCMCIA An	expansion	bus	architecture	that	has	found	widespread
acceptance	as	a	de	facto	standard	in	notebook-size
computers.	PCMCIA	originated	as	a	specification	for	add-
on	memory	cards	written	by	the	Personal	Computer
Memory	Card	International	Association.

PFI programmable	function	interface—general	purpose	input
terminals,	fixed	purpose	output	terminals.	The	name	of	the
fixed	output	signal	is	often	placed	on	the	I/O	connector
next	to	the	terminal	as	a	hint.

physical
channel

Refer	to	channel.

PID proportional	integral	derivative—Combination	of
proportional,	integral,	and	derivative	control	actions.
Refers	to	a	control	method	in	which	the	controller	output	is
proportional	to	the	error,	its	time	history,	and	the	rate	at
which	it	is	changing.	The	error	is	the	difference	between
the	observed	and	desired	values	of	a	variable	that	is
under	control	action.

pin Refer	to	terminal.



Poisson's
Ratio

The	negative	ratio	of	the	strain	in	the	transverse	direction
(perpendicular	to	the	force)	to	the	strain	in	the	axial
direction	(parallel	to	the	force).

port A	collection	of	digital	lines.	Usually	the	lines	are	grouped
into	either	a	8-bit	or	32-bit	port.	Most	E	Series	devices
have	one	8-bit	port.

port	width The	number	of	lines	in	a	port.	For	example,	most	E	Series
devices	have	one	port	with	eight	lines;	therefore,	the	port
width	is	eight.

position
sensor

Refer	to	linear	displacement	sensor.

posttrigger
samples

If	there	is	no	Reference	Trigger,	posttrigger	samples	are
the	data	acquired	after	the	task	is	started.	If	there	is	a
Reference	Trigger,	this	is	the	data	acquired	after	the
Reference	Trigger.

plug	and
play	devices

Devices	that	do	not	require	DIP	switches	or	jumpers	to
configure	resources	on	the	devices.	Also	called	switchless
devices.

plug	and
play	sensors

A	transducer	with	an	associated	TEDS—includes	both
Virtual	TEDS	and	smart	TEDS	sensors.

pretrigger
samples

Data	acquired	before	the	occurrence	of	the	Reference
Trigger.

pretriggering The	technique	used	on	a	measurement	device	to	keep	a
circular	buffer	filled	with	samples,	so	that	when	the
Reference	Trigger	conditions	are	met,	the	buffer	includes
samples	leading	up	to	the	trigger	condition	as	well	as
samples	acquired	immediately	after	the	trigger.

programmed
I/O

A	data	transfer	mechanism	in	which	a	buffer	is	not	used
and	instead,	the	computer	reads	and	writes	directly	to	the
device.

propagation
delay

The	amount	of	time	required	for	a	signal	to	pass	through	a
circuit.

pulsed A	form	of	counter	signal	generation	by	which	a	pulse	is



output generated	when	a	counter	reaches	a	certain	value.
PWM pulse-width	modulation
PXI PCI	eXtensions	for	Instrumentation—a	rugged,	open

system	for	modular	instrumentation	based	on
CompactPCI,	with	special	mechanical,	electrical,	and
software	features.	The	PXI	standard	was	originally
developed	by	National	Instruments	in	1997	and	is	now
managed	by	the	PXI	Systems	Alliance.

PXI	trigger
bus

The	timing	bus	that	connects	PXI	DAQ	devices	directly,	by
means	of	connectors	built	into	the	backplane	of	the	PXI
chassis,	for	precise	synchronization	of	functions.	This	bus
is	functionally	equivalent	to	the	RTSI	bus	for	PCI	DAQ
devices.



R
range The	minimum	and	maximum	analog	signal	levels	that	the

ADC	can	digitize.
raw Data	that	has	not	been	changed	in	any	way.	For	input,	data

is	returned	exactly	as	received	from	the	device.	For	output,
data	is	written	as	is	to	the	device.	Refer	to	unscaled	and
scaled.

real	time A	property	of	an	event	or	system	in	which	samples	are
processed	as	they	are	acquired	instead	of	being
accumulated	and	processed	at	a	later	time.

referenced
signal
source

Signal	sources	with	voltage	signals	that	are	referenced	to	a
system	ground,	such	as	the	earth	or	a	building	ground.	Also
called	grounded	signal	sources.

resolution The	smallest	amount	of	input	signal	change	that	a	device	or
sensor	can	detect.	The	term	discrimination	is	also	used	for
resolution.

rise	time The	time	for	a	signal	to	transition	from	10%	to	90%	of	the
maximum	signal	amplitude.

route A	connection	between	a	pair	of	terminals.	Any	time	the
source	or	destination	terminal	of	a	signal	is	specified,	a
route	is	created.

RSE Referenced	single-ended	mode—all	measurements	are
made	with	respect	to	a	common	reference	measurement
system	or	a	ground.	Also	called	a	grounded	measurement
system.

RTD Resistance	temperature	detector—a	metallic	probe	that
measures	temperature	based	on	its	coefficient	of	resistivity.

RTSI	bus Real-time	system	integration	bus—the	NI	timing	bus	that
connects	DAQ	devices	directly,	by	means	of	connectors	on
top	of	the	devices,	for	precise	synchronization	of	functions.
This	bus	is	functionally	equivalent	to	the	PXI	Trigger	bus	for
PXI	DAQ	devices.



RVDT rotary	variable	differential	transformer—a	sensor	whose
output	signal	represents	the	rotation	of	the	shaft.



S
s seconds
S samples.	Refer	to	sample.
S/s samples	per	second—used	to	express	the	rate	at	which	a

measurement	device	samples	an	analog	signal.
sample A	single	measurement	from	a	single	channel	or,	for	output,

a	single	generation	to	a	single	channel.
sample
clock

The	clock	that	initiates	an	acquisition	of	one	sample	from
each	channel	in	the	scan	list.	For	example,	with	each
sample	clock	pulse,	M	Series	devices	acquire	a	sample	on
each	analog	input	channel	in	a	task	by	multiplexing	each
channel	through	a	single	ADC.	On	simultaneous	sampling
devices,	the	sample	clock	initiates	the	simultaneous
acquisition	of	one	sample	from	each	channel	in	the	task
through	a	dedicated,	per-channel	ADC.	No	multiplexing
(and	therefore	no	convert	clock)	is	necessary	for	S	Series
devices.

sample
clock	rate

Refer	to	sample	rate.

sample	rate The	number	of	samples	per	channel	per	second.	For
example,	a	sample	rate	of	10	S/s	means	sampling	each
channel	10	times	per	second.

scale Data	that	has	been	mathematically	transformed	into
engineering	units.	Other	manipulations	also	can	be	done
such	as	reordering	to	match	the	channel	order.

scanning Method	of	sequentially	connecting	channels.
SCC Signal	conditioning	component—low	channel	count	analog

or	digital	I/O	modules	for	conditioning	DAQ	systems.
SCXI Signal	Conditioning	eXtensions	for	Instrumentation—the

NI	product	line	for	conditioning	low-level	signals	within	an
external	chassis	near	sensors	so	that	only	high-level
signals	are	sent	to	measurement	devices	in	the	noisy	PC



environment.	SCXI	is	an	open	standard	available	for	all
vendors.

sensor A	device	that	responds	to	a	physical	stimulus	(heat,	light,
sound,	pressure,	motion,	flow,	and	so	on)	and	produces	a
corresponding	electrical	signal.

signal A	means	of	conveying	information.	An	analog	waveform,	a
clock,	and	a	single	digital	(TTL)	edge	are	all	examples	of
signals.

signal
conditioning

The	manipulation	of	signals	to	prepare	them	for	digitizing.

smart	TEDS
sensor

A	transducer	with	a	built-in	self-identification	EEPROM
that	provides	the	TEDS.

software
timing

A	means	of	controlling	signal	generation.	The	software,
such	as	NI-DAQmx,	and	the	operating	system	control	the
rate	of	generation.

software
trigger

A	VI	or	function	that,	when	it	executes,	triggers	an	action
such	as	starting	an	acquisition.

source
impedance

A	parameter	of	signal	sources	that	reflects	current-driving
ability	of	voltage	sources	(lower	is	better)	and	the	voltage-
driving	ability	of	current	sources	(higher	is	better).

static	AO Analog	output	operations	that	use	software	timing.
static	digital
I/O

Software-timed	digital	I/O	operations	that	do	not	involve
the	use	of	control	signals	in	data	transfers.	Also	known	as
software-timed	I/O	or	unstrobed	I/O.

strain The	amount	of	deformation	of	a	body	due	to	an	applied
force.

strobed	I/O Any	operation	in	which	every	data	transfer	is	timed	by
hardware	signals.	In	the	case	of	sample	clock	timing,	this
hardware	signal	is	a	clock	edge.	In	the	case	of
handshaking	I/O,	hardware	signals	involve	two	or	three
handshaking	lines.

STC system	timing	controller
synchronous 1.	 Hardware—a	signal	that	occurs	or	is	acted	upon	in



synchrony	with	another	signal,	such	as	a	reference
clock.

2.	 Software—a	VI	or	function	that	begins	an	operation
and	returns	only	when	the	operation	is	complete.



T
task In	NI-DAQmx,	a	collection	of	one	or	more	channels,

timing,	and	triggering	and	other	properties	that	apply	to
the	task	itself.	Conceptually,	a	task	represents	a
measurement	or	generation	you	want	to	perform.

task	buffer Refer	to	buffer.
TCR temperature	coefficient	of	resistance—the	average

resistance	change	per	one	degree	at	temperatures
between	0	°C	and	100	°C.

TEDS transducer	electronic	data	sheet—standardized	data
structure,	defined	by	IEEE	1451.4,	for	describing
sensors,	typically	stored	in	nonvolatile	memory	within	a
sensor.	The	manufacturer	of	the	sensor	stores,	into	this
memory,	initial	information	such	as	manufacturer	name,
sensor	type,	model	number,	serial	number,	and
calibration	data.	The	TEDS	data	structure	also	includes
space	for	custom	information	such	as	channel	ID,
location,	position,	direction,	tag	number,	etc.	Alternatively,
the	TEDS	data	may	be	stored	in	a	file	or	database	record
as	a	Virtual	TEDS.	For	information	on	IEEE	1451.4-
compliant	TEDS	sensors,	refer	to	www.ni.com/pnp.

TEDS	Class	I
Sensor

A	smart	TEDS	sensor	with	a	constant-current	powered
transducer	with	a	two-wire	interface,	such	as	an
accelerometer.	Class	I	transducers	also	include	diodes	or
analog	switches	with	which	the	multiplexing	of	the	analog
signal	with	the	digital	TEDS	information	on	the	single	pair
of	wires	is	possible.	The	digital	portion	of	the	mixed-mode
interface	(Class	1	or	Class	2)	is	based	on	the	1-Wire
protocol	from	Maxim/Dallas	Semiconductor.

TEDS	Class
II	Sensor

A	smart	TEDS	sensor	with	separate	wires	for	the	analog
and	digital	portions	of	the	TEDS	mixed-mode	interface.
The	analog	input/output	of	the	transducer	is	left
unmodified,	and	the	digital	TEDS	circuit	is	added	in
parallel,	such	as	thermocouples,	RTDs,	and	bridge-based
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sensors.	The	digital	portion	of	the	mixed-mode	interface
(Class	1	or	Class	2)	is	based	on	the	1-Wire	protocol	from
Maxim/Dallas	Semiconductor.

terminal A	named	location	on	a	DAQ	device	where	a	signal	is
either	generated	(output	or	produced)	or	acquired	(input
or	consumed).

terminal
count

When	counting	up,	an	N	bit	counter	reaches	its	terminal
count	at	2N	-1.	An	N	bit	counter	counting	down	reaches
its	terminal	count	at	0.

thermistor A	semiconductor	sensor	that	produces	a	repeatable
change	in	electrical	resistance	as	a	function	of
temperature.	Most	thermistors	have	a	negative
temperature	coefficient.

thermocouple A	temperature	sensor	created	by	joining	two	dissimilar
metals.	The	junction	produces	a	small	voltage	as	a
function	of	the	temperature.

threshold The	voltage	level	a	signal	must	reach	for	a	trigger	to
occur.

tick A	digital	edge	of	a	clock.
timebase A	clock	that	is	divided	down	to	produce	another	clock	or	a

clock	provided	to	a	counter	for	measuring	elapsed	time.
Traditional
NI-DAQ
(Legacy)

An	upgrade	of	the	earlier	version	of	NI-DAQ.	Traditional
NI-DAQ	(Legacy)	has	the	same	VIs	and	functions	and
works	the	same	way	as	NI-DAQ	6.9.x,	except	you	can
use	both	Traditional	NI-DAQ	(Legacy)	and	NI-DAQmx	on
the	same	computer,	and	some	hardware	is	no	longer
supported.

transducer Refer	to	sensor.
transducer
excitation

A	type	of	signal	conditioning	that	uses	external	voltages
and	currents	to	excite	the	circuitry	of	a	signal	conditioning
system	into	measuring	physical	phenomena.

trigger Any	signal	that	causes	a	device	to	perform	an	action,
such	as	starting	an	acquisition.



TTL Transistor-transistor	logic—a	signal	having	two	discrete
levels,	a	high	and	a	low	level.



U
unipolar A	signal	range	that	is	always	positive	(for	example,	0	to	+10

V).
unscaled Samples	in	the	integer	form	that	the	hardware	produces	or

requires.	Although	no	mathematical	transformations	are
applied	to	unscaled	data,	other	manipulations	may	be	done
such	as	reordering	to	match	the	channel	order.

unstrobed
I/O

Refer	to	static	digital	I/O.



V
V volts
VI Virtual	instrument.	Refer	to	virtual	instrument.
virtual
channel

Refer	to	channel.

virtual
instrument

A	program	in	LabVIEW	that	models	the	appearance	and
function	of	a	physical	instrument.

VISA Virtual	Instrumentation	Software	Architecture.



W
waveform	data
type

A	LabVIEW	data	type	that	bundles	timing	information
along	with	the	data.

WDT Refer	to	waveform	data	type.



Important	Information
Refer	to	the	following	topics	for	more	information	on	warranty	and	legal
statements	related	to	NI	products.
Warranty
Copyright
Trademarks
Patents
Warning	Regarding	Use	of	NI	Products



Warranty
The	media	on	which	you	receive	National	Instruments	software
are	warranted	not	to	fail	to	execute	programming	instructions,
due	to	defects	in	materials	and	workmanship,	for	a	period	of	90
days	from	date	of	shipment,	as	evidenced	by	receipts	or	other
documentation.	National	Instruments	will,	at	its	option,	repair	or
replace	software	media	that	do	not	execute	programming
instructions	if	National	Instruments	receives	notice	of	such
defects	during	the	warranty	period.	National	Instruments	does
not	warrant	that	the	operation	of	the	software	shall	be
uninterrupted	or	error	free.
A	Return	Material	Authorization	(RMA)	number	must	be
obtained	from	the	factory	and	clearly	marked	on	the	outside	of
the	package	before	any	equipment	will	be	accepted	for
warranty	work.	National	Instruments	will	pay	the	shipping	costs
of	returning	to	the	owner	parts	which	are	covered	by	warranty.
National	Instruments	believes	that	the	information	in	this
document	is	accurate.	The	document	has	been	carefully
reviewed	for	technical	accuracy.	In	the	event	that	technical	or
typographical	errors	exist,	National	Instruments	reserves	the
right	to	make	changes	to	subsequent	editions	of	this	document
without	prior	notice	to	holders	of	this	edition.	The	reader	should
consult	National	Instruments	if	errors	are	suspected.	In	no
event	shall	National	Instruments	be	liable	for	any	damages
arising	out	of	or	related	to	this	document	or	the	information
contained	in	it.
EXCEPT	AS	SPECIFIED	HEREIN,	NATIONAL	INSTRUMENTS
MAKES	NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AND
SPECIFICALLY	DISCLAIMS	ANY	WARRANTY	OF
MERCHANTABILITY	OR	FITNESS	FOR	A	PARTICULAR
PURPOSE.	CUSTOMER'S	RIGHT	TO	RECOVER	DAMAGES



CAUSED	BY	FAULT	OR	NEGLIGENCE	ON	THE	PART	OF
NATIONAL	INSTRUMENTS	SHALL	BE	LIMITED	TO	THE
AMOUNT	THERETOFORE	PAID	BY	THE	CUSTOMER.
NATIONAL	INSTRUMENTS	WILL	NOT	BE	LIABLE	FOR
DAMAGES	RESULTING	FROM	LOSS	OF	DATA,	PROFITS,
USE	OF	PRODUCTS,	OR	INCIDENTAL	OR
CONSEQUENTIAL	DAMAGES,	EVEN	IF	ADVISED	OF	THE
POSSIBILITY	THEREOF.	This	limitation	of	the	liability	of
National	Instruments	will	apply	regardless	of	the	form	of	action,
whether	in	contract	or	tort,	including	negligence.	Any	action
against	National	Instruments	must	be	brought	within	one	year
after	the	cause	of	action	accrues.	National	Instruments	shall	not
be	liable	for	any	delay	in	performance	due	to	causes	beyond	its
reasonable	control.	The	warranty	provided	herein	does	not
cover	damages,	defects,	malfunctions,	or	service	failures
caused	by	owner's	failure	to	follow	the	National	Instruments
installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent
acts;	and	power	failure	or	surges,	fire,	flood,	accident,	actions
of	third	parties,	or	other	events	outside	reasonable	control.



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or
transmitted	in	any	form,	electronic	or	mechanical,	including	photocopying,
recording,	storing	in	an	information	retrieval	system,	or	translating,	in
whole	or	in	part,	without	the	prior	written	consent	of	National	Instruments
Corporation.



Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks
of	National	Instruments	Corporation.	Refer	to	the	Terms	of	Use
section	on	ni.com/legal	for	more	information	about	National
Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,
Simulink®,	Stateflow®,	and	xPC	TargetBox®	are	registered
trademarks,	and	TargetBox™	and	Target	Language	Compiler™
are	trademarks	of	The	MathWorks,	Inc.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
Other	product	and	company	names	mentioned	herein	are
trademarks	or	trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program
are	business	entities	independent	from	National	Instruments
and	have	no	agency,	partnership,	or	joint-venture	relationship
with	National	Instruments.
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Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the	patents.txt	file
on	your	CD,	or	ni.com/patents.
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WARNING	REGARDING	USE	OF	NATIONAL
INSTRUMENTS	PRODUCTS
(1)	NATIONAL	INSTRUMENTS	PRODUCTS	ARE	NOT
DESIGNED	WITH	COMPONENTS	AND	TESTING	FOR	A
LEVEL	OF	RELIABILITY	SUITABLE	FOR	USE	IN	OR	IN
CONNECTION	WITH	SURGICAL	IMPLANTS	OR	AS
CRITICAL	COMPONENTS	IN	ANY	LIFE	SUPPORT	SYSTEMS
WHOSE	FAILURE	TO	PERFORM	CAN	REASONABLY	BE
EXPECTED	TO	CAUSE	SIGNIFICANT	INJURY	TO	A	HUMAN.
(2)	IN	ANY	APPLICATION,	INCLUDING	THE	ABOVE,
RELIABILITY	OF	OPERATION	OF	THE	SOFTWARE
PRODUCTS	CAN	BE	IMPAIRED	BY	ADVERSE	FACTORS,
INCLUDING	BUT	NOT	LIMITED	TO	FLUCTUATIONS	IN
ELECTRICAL	POWER	SUPPLY,	COMPUTER	HARDWARE
MALFUNCTIONS,	COMPUTER	OPERATING	SYSTEM
SOFTWARE	FITNESS,	FITNESS	OF	COMPILERS	AND
DEVELOPMENT	SOFTWARE	USED	TO	DEVELOP	AN
APPLICATION,	INSTALLATION	ERRORS,	SOFTWARE	AND
HARDWARE	COMPATIBILITY	PROBLEMS,	MALFUNCTIONS
OR	FAILURES	OF	ELECTRONIC	MONITORING	OR
CONTROL	DEVICES,	TRANSIENT	FAILURES	OF
ELECTRONIC	SYSTEMS	(HARDWARE	AND/OR
SOFTWARE),	UNANTICIPATED	USES	OR	MISUSES,	OR
ERRORS	ON	THE	PART	OF	THE	USER	OR	APPLICATIONS
DESIGNER	(ADVERSE	FACTORS	SUCH	AS	THESE	ARE
HEREAFTER	COLLECTIVELY	TERMED	"SYSTEM
FAILURES").	ANY	APPLICATION	WHERE	A	SYSTEM
FAILURE	WOULD	CREATE	A	RISK	OF	HARM	TO	PROPERTY
OR	PERSONS	(INCLUDING	THE	RISK	OF	BODILY	INJURY
AND	DEATH)	SHOULD	NOT	BE	RELIANT	SOLELY	UPON
ONE	FORM	OF	ELECTRONIC	SYSTEM	DUE	TO	THE	RISK
OF	SYSTEM	FAILURE.	TO	AVOID	DAMAGE,	INJURY,	OR



DEATH,	THE	USER	OR	APPLICATION	DESIGNER	MUST
TAKE	REASONABLY	PRUDENT	STEPS	TO	PROTECT
AGAINST	SYSTEM	FAILURES,	INCLUDING	BUT	NOT
LIMITED	TO	BACK-UP	OR	SHUT	DOWN	MECHANISMS.
BECAUSE	EACH	END-USER	SYSTEM	IS	CUSTOMIZED	AND
DIFFERS	FROM	NATIONAL	INSTRUMENTS'	TESTING
PLATFORMS	AND	BECAUSE	A	USER	OR	APPLICATION
DESIGNER	MAY	USE	NATIONAL	INSTRUMENTS
PRODUCTS	IN	COMBINATION	WITH	OTHER	PRODUCTS	IN
A	MANNER	NOT	EVALUATED	OR	CONTEMPLATED	BY
NATIONAL	INSTRUMENTS,	THE	USER	OR	APPLICATION
DESIGNER	IS	ULTIMATELY	RESPONSIBLE	FOR	VERIFYING
AND	VALIDATING	THE	SUITABILITY	OF	NATIONAL
INSTRUMENTS	PRODUCTS	WHENEVER	NATIONAL
INSTRUMENTS	PRODUCTS	ARE	INCORPORATED	IN	A
SYSTEM	OR	APPLICATION,	INCLUDING,	WITHOUT
LIMITATION,	THE	APPROPRIATE	DESIGN,	PROCESS	AND
SAFETY	LEVEL	OF	SUCH	SYSTEM	OR	APPLICATION.



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	National	Instruments	Web	site
at	ni.com	for	technical	support	and	professional	services:

Support—Online	technical	support	resources	at
ni.com/support	include	the	following:

Self-Help	Resources—For	answers	and	solutions,
visit	the	award-winning	National	Instruments	Web
site	for	software	drivers	and	updates,	a	searchable
KnowledgeBase,	product	manuals,	step-by-step
troubleshooting	wizards,	thousands	of	example
programs,	tutorials,	application	notes,	instrument
drivers,	and	so	on.
Free	Technical	Support—All	registered	users
receive	free	Basic	Service,	which	includes	access	to
hundreds	of	Applications	Engineers	worldwide	in	the
NI	Discussion	Forums	at	forums.ni.com.	National
Instruments	Applications	Engineers	make	sure	every
question	receives	an	answer.
For	information	about	other	technical	support	options
in	your	area,	visit	ni.com/services	or	contact	your	local
office	at	ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-
paced	training,	eLearning	virtual	classrooms,	interactive
CDs,	and	Certification	program	information.	You	also	can
register	for	instructor-led,	hands-on	courses	at	locations
around	the	world.
System	Integration—If	you	have	time	constraints,	limited
in-house	technical	resources,	or	other	project	challenges,
National	Instruments	Alliance	Partner	members	can	help.
To	learn	more,	call	your	local	NI	office	or	visit
ni.com/alliance.
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Declaration	of	Conformity	(DoC)—A	DoC	is	our	claim	of
compliance	with	the	Council	of	the	European
Communities	using	the	manufacturer​s	declaration	of
conformity.	This	system	affords	the	user	protection	for
electronic	compatibility	(EMC)	and	product	safety.	You	can
obtain	the	DoC	for	your	product	by	visiting
ni.com/certification.
Calibration	Certificate—If	your	product	supports
calibration,	you	can	obtain	the	calibration	certificate	for
your	product	at	ni.com/calibration.

If	you	searched	ni.com	and	could	not	find	the	answers	you
need,	contact	your	local	office	or	NI	corporate	headquarters.
You	also	can	visit	the	Worldwide	Offices	section	of
ni.com/niglobal	to	access	the	branch	office	Web	sites,	which
provide	up-to-date	contact	information,	support	phone	numbers,
email	addresses,	and	current	events.
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Branch	Offices
Office Telephone	Number
Australia 1800	300	800
Austria 43	662	457990-0
Belgium 32	(0)	2	757	0020
Brazil 55	11	3262	3599
Canada 800	433	3488
China 86	21	5050	9800
Czech	Republic 420	224	235	774
Denmark 45	45	76	26	00
Finland 385	(0)	9	725	72511
France 33	(0)	1	48	14	24	24
Germany 49	89	7413130
India 91	80	41190000
Israel 972	0	3	6393737
Italy 39	02	413091
Japan 81	3	5472	2970
Korea 82	02	3451	3400
Lebanon 961	(0)	1	33	28	28
Malaysia 1800	887710
Mexico 01	800	010	0793
Netherlands 31	(0)	348	433	466
New	Zealand 0800	553	322
Norway 47	(0)	66	90	76	60
Poland 48	22	3390150
Portugal 351	210	311	210



Russia 7	495	783	6851
Singapore 1800	226	5886
Slovenia 386	3	425	42	00
South	Africa 27	0	11	805	8197
Spain 34	91	640	0085
Sweden 46	(0)	8	587	895	00
Switzerland 41	56	2005151
Taiwan 886	02	2377	2222
Thailand 662	278	6777
Turkey 90	212	279	3031
United	Kingdom 44	(0)	1635	523545
United	States	(Corporate) 512	683	0100
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